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Anleitungen (de) / Manuals (en) / Instrucciones (es) / Odnyieg xpriong (el) /
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Die Anleitung ,Erweiterte Informationen” finden Sie im COMfortel Set und auf unserer Internetseite. Die de

Kurzanleitung finden Sie auf unserer Internetseite. Nach einem Firmware-Update bendtigen Sie ggf.
aktualisierte Anleitungen. Diese finden Sie auf unserer Internetseite.

You will find the "Advanced Information" manuals in the COMfortel Set software and on our website. You | en
will find the Quick Guide on our website. After a firmware update you usually require a new version of the
instructions. You will find this on our website.

Encontrara las instrucciones del apartado "Advanced Information" en COMfortel Set y en nuestra pagina | es
web. En nuestra pagina web encontrara la Guia rapida. Después de efectuar una actualizacién del
firmware es posible que necesite descargar una copia actualizada de las instrucciones. La encontrara en
nuestra pagina web.

O1 0dnyieg xpriong "Advanced Information” utrépyouv oto COMfortel Set kai aTo SiadikTuo. O1 cuvoTITIKEG | el
odnyieg Xprong utrapxouv aTo d1adikTuo. MeTd TNV evnuépwon Tou UAIKOAOYIOHIKOU Ba XPEINOTEITE €VD.
evnuepwpEVeSG odnyieg Xpriong. Mropeite va Tig Bpeite oTo dladikTuo.

La notice « Advanced Information » est disponible dans le COMfortel Set ainsi que sur notre site Internet. | fr
Vous trouverez la notice abrégée sur notre site Internet. Aprés une mise a jour de la version du logiciel,
vous aurez besoin de notices actualisées. Elles sont disponibles sur notre site Internet.

La guida “Advanced Information” & disponibile in COMfortel Set e sul nostro sito web. La guida rapida & it
disponibile sul nostro sito web. Dopo un aggiornamento del firmware possono servire guide aggiornate.
Queste sono disponibili sul nostro sito web.

De handleiding “Advanced Information” vindt u in de COMfortel Set van de telefoon en op onze nl
internetpagina. Een korte handleiding vindt u op onze internetpagina. Na een firmware-update heeft u evt.
geactualiseerde handleidingen nodig. Deze vindt u op onze internetpagina.

Instrukcja ,Advanced Information” znajduje sie w COMfortel Set i na naszej stronie internetowej. Skrécona | pl
instrukcja znajduje sie na naszej stronie internetowej. Po zaktualizowaniu oprogramowania wewnetrznego
moga by¢ ewentualnie potrzebne zaktualizowane instrukcje. Mozna je znalez¢ na naszej stronie
internetowej.

Copyright
© Auerswald GmbH & Co. KG, 38162 Cremlingen, Germany, 2018

The software included in this product contains also copyrighted software that is licenced under various licences. A copy of these licences is included in this document

Apache License

Version 2.0, January 2004

Android Ring Tones: Copyright (c) 2009 Android Open Source Project

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this fle except in compliance with the License. You may obtain a copy of the License at http:/iwww.apache.orgflicenses/LICENSE-2.0
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See
the License for the specific language governing permissions and limitations under the License.

BSD License

Newlib sources licensed using BSD 3-clause license: Sources from the following contributors in the newlib subdirecory are licensed using the BSD 3-clause license:

(2) University of California, Berkeley. Copyright (c) 1981-2000 The Regents of the University of California. All rights reserved.

(11) Christopher G. Demetriou. Copyright (c) 2001 Christopher G. Demetriou. Al rights reserved.

(13) Royal Institute of Technology. Copyright (c) 1999 Kungliga Tekniska Hogskolan (Royal Institute of Technology, Stockholm, Sweden). All rights reserved.

(19) Todd C. Miler. Copyright (c) 1998 Todd C. Miller <Todd.Miler@courtesan.com>. Al rights reserved.

(35) - ARM Ltd (arm and thumb variant targets only). Copyright (c) 2009 ARM Ltd. All rights reserved.

The BSD 3-clause license: Copyright (c) <YEAR>, <OWNER> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

*Neither the name of the <ORGANIZATION> nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTER-
RUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Newlib sources licensed using BSD 2-clause license: Sources from the following contributors in the newlib subdirecory are licensed using the BSD 2-clause license:

(14) Alexey Zelkin. Copyright (c) 2000, 2001 Alexey Zelkin <phantom@FreeBSD.org>. Al rights reserved

(15) Andrey A. Chernov. Copyright (C) 1997 by Andrey A. Chernov, Moscow, Russia. Allrights reserved

(16) FreeBSD. Copyright (c) 1997-2002 FreeBSD Project. All rights reserved.

(18) Citrus Project. Copyright (c)1999 Citrus Project. All rights reserved.

(27) Konstantin Chuguev (~enable-newlib-iconv). Copyright (c) 1999, 2000 Konstantin Chuguev. All rights reserved.

(28) Artem Bityuckiy (~enable-newlib-iconv). Copyright (c) 2003, Artem B. Bityuckiy, SoftMine Corporation. Rights transferred to Franklin Electronic Publishers.

(26) Mike Barcroft. Copyright (c) 2001 Mike Barcroft <mike@FreeBSD.org>. Allrights reserved.

(30) - Alex Tatmanjants (targets using libc/posix). Copyright (c) 1995 Alex Tatmanjants <alex@elvisti kiev.ua> at Electronni Visti IA, Kiev, Ukraine. All rights reserved

(31) - M. Warner Losh (targets using libc/posix). Copyright (c) 1998, M. Wamer Losh <imp@ireebsd.org>. Al rights reserved.

(32) - Andrey A. Chemov (targets using libc/posix). Copyright (C) 1996 by Andrey A. Chemov, Moscow, Russia. Al rights reserved.

(33) - Daniel Eischen (targets using libc/posix). Copyright (c) 2001 Daniel Eischen <deischen@FreeBSD.org>. All rights reserved.

The BSD 2-clause license: Copyright (c) <YEAR>, <OWNER> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

*Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,



SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTER-
RUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Deja Vu License

Fonts are © Bitstream (see below). DejaVu changes are in public domain. Explanation of copyright is on Gnome page on Bitstream Vera fonts. Glyphs imported from Arev fonts are © Tavmjung Bah (see below)

Bitstream Vera Fonts Copyright: Copyright (c) 2003 by Bitstream, Inc Al Rights Reserved. Bitstream Vera is a trademark of Bitstream, Inc.

Permission is hereby granted, free of charge, to any ("Fonts") files (the "Font Software"), to reproduce and distribute the Font Software,
including without limitation the rights to use, copy, merge, publish, dlsmnme, and/or sell copies of the Font Software, and to permit persons to whom the Font Software is fumished to do so, subject to the following conditions:
The above copyright and trademark notices and this permission notice shall be included in all copies of one or more of the Font Software typefaces.

The Font Software may be modified, altered, or added to, and in particular the designs of glyphs or characters in the Fonts may be modified and additional glyphs or characters may be added to the Fonts, only if the fonts are
renamed to names not containing either the words "Bitstream"” or the word "Vera".

This License becomes null and void to the extent applicable to Fonts or Font Software that has been modified and is distributed under the "Bitstream Vera" names.

The Font Software may be sold as part of a larger software package but no copy of one or more of the Font Software typefaces may be sold by itself,

THE FONT SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL BITSTREAM OR THE GNOME FOUNDATION BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.

Except as contained in this notice, the names of Gnome, the Gnome Foundation, and Bitstream Inc., shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Font Software without prior
‘written authorization from the Gnome Foundation or Bitstream Inc., respectively. For further information, contact: fonts at gnome dot org.

Arev Fonts Copyright : Copyright (c) 2006 by Tavmjong Bah. All Rights Reserved.

Permission is hereby granted, fre of charge, to any person obtaining a copy of the this license ("Fonts") and files (the "Font Software"), to reproduce and distribute the modifications
to the Bitstream Vera Font Software, including without limitation the rights to use, copy, merge, publish, distribute, and/or sell copies of the Font Software, and to permit persons to whom the Font Software is furnished to do so,
subject to the following conditions:

The above copyright and trademark notices and this permission notice shall be included in all copies of one or more of the Font Software typefaces.

The Font Software may be modified, altered, or added to, and in particular the designs of glyphs or characters in the Fonts may be modified and additional glyphs or characters may be added to the Fonts, only if the fonts are
renamed to names not containing either the words “Tavmjong Bah" or the word "Arev".

This License becomes null and void to the extent applicable to Fonts or Font Software that has been modified and is distributed under the "Tavmjong Bah Arev" names.

The Font Software may be sold as part of a larger software package but no copy of one or more of the Font Software typefaces may be sold by itself.

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL TAVMJONG BAH BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF THE USE OR INABILITY
TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.

Except as contained in this notice, the name of Tavmjong Bah shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Font Software without prior written authorization from Tavmjong Bah
For further information, contact: tavmjong @ free . fr.

Freetype2-Library

Freetype credits: Portions of this software are copyright © 2014 The FreeType Project (www.freetype.org). Al rights reserved
JPEG License

This software is based in part on the work of e Independent JPEG Group.

Newlib License

The newlib subdirectory is a collection of software from several sources. Each file may have its own copyrightllicense that is embedded in the source file. Unless otherwise noted in the body of the source file(s), the following
copyright notices will apply to the contents of the newlib subdirectory:

(1) Red Hat Incorporated. Copyright (c) 1994-2009 Red Hat, Inc. Al rights reserved

ing to use, modify, copy, of redistribute it subject to the terms and conditions of the BSD License. This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY expressed or implied, including the implied warranties of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at http://www.opensource.org/licenses. Any Red
Hat trademarks that are incorporated in the source code or documentation are not subject to the BSD License and may only be used or replicated with the express permission of Red Hat, Inc.

The author of this software is David M. Gay.

Copyright (C) 1998-2001 by Lucent Technologies. All Rights Reserved

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright
notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software
‘without specific, written prior permission.

LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. INNO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES
BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

(3) David M. Gay (AT&T 1991, Lucent 1998). The author of this software is David M. Gay. Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this
software and in all copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING
THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

(4) Advanced Micro Devices. Copyright 1989, 1990 Advanced Micro Devices, Inc.

This software is the property of Advanced Micro Devices, Inc (AMD) which specifically grants the user the right to modify, d distribute this softy notice is not removed or altered. Al other rights are reserved
by AMD.

/AMD MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS SOFTWARE. INNO EVENT SHALL AMD BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION
WITH OR ARISING FROM THE FURNISHING, PERFORMANCE, OR USE OF THIS SOFTWARE.

S0 that all may beneft from your experience, please report any problems or suggestions about this software to the 29K Technical Support Center at 800-29-29-AMD (800-262-9263) n the USA, or 0800-89-1131 in the UK,
or 0031-11-1129 in Japan, toll free. The direct dial number is 512-462-4118.

Advanced Micro Devices, Inc., 29K Support Products, Mail Stop 573, 5900 E. Ben White Bivd., Austin, TX 78741, 800-292-9263

(7) Sun Microsystems. Copyright (c) 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunPro, a Sun Microsystems, Inc. business.

Permission to use, copy, modiy, and distrbute this software is freely granted, provided that this nofice s preserved

(8) Hewlett Packard. (c) Copyright 1986 HEWLETT-PACKARD COMPANY

To anyone who acknowledges that tisfl is provided "AS IS" without any express or implied warranty: permission to use, copy, modily, and distrbute tis fle fo any pupose is hereby granted without fee, provided that the.
above copyright notice and this notice appears in all copies, and that the name of Hewlett-Packard Company not be used in advertising or publicity pertaining ithout specific, written prior permission,
Hewlett-Packard Company makes no representations about the suitability of this software for any purpose.

(9) Hans-Peter Nilsson. Copyright (C) 2001 Hans-Peter Nilsson

Permission to use, copy, modify, this software for any purp fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this
software and in al copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING
"THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

(17) S. L. Moshier. Author: S. L. Moshier. Copyright (c) 1984,2000 S.L. Moshier

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this
software and in al copies of the supporting documentation for such software.

THIS SOFTWARE 1S BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING
THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

Trademarks

Microsoft and Windows are registered trademarks of the Microsoft Corporation in the U.S.A. and/or other countries. Bitstream
Vera Font f 2003 Bitstream, Inc. All rights reserved. Bitstream Vera is a trademark of Bitstream, Inc.. Arev Font f Tavmjong
Bah. All rights reserved. All other trademarks mentioned are the property of the corresponding manufacturer. This product
contains software which is based in part on the work of the Independent JPEG Group.
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Headsetbuchse (de) / Headset Socket (en) / Conexion auriculares (es) /
Ymodoxn ot akouoTiIKwyv (el) / Connecteur micro-casque (fr) / Presa per
cuffia auricolare (it) / Aansluiting headset (nl) / Gniazdo zestawu
stuchawkowego (pl)

1 - Mikrofon (de) / Microphone (en) / Micréfono (es) / Mikpdgwvo (el) / Microphone (fr) / Microfono
(it) / Microfoon (nl) / Mikrofon (pl)

2 - Lautsprecher (de) / Loudspeaker (en) / Altavoz (es) / Hxeio (el) / Haut-parleur (fr) / Altoparlante
(it) / Luidspreker (nl) / Gtosnik (pl)

3 + Lautsprecher (de) / Loudspeaker (en) / Altavoz (es) / Hxeio (el) / Haut-parleur (fr) / Altoparlante
(it) / Luidspreker (nl) / Gtosnik (pl)

4 + Mikrofon (de) / Microphone (en) / Micréfono (es) / Mikpdgwvo (el) / Microphone (fr) / Microfono

(it) / Microfoon (nl) / Mikrofon (pl)
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Deutsch

Wichtige Informationen

Sicherheitshinweise

Warnung: UnsachgemafRer Umgang mit dem Gerat kann zu einem
lebensgefahrlichen elektrischen Schlag fuhren und das Gerat
beschadigen oder zerstoren.
* Lesen Sie die zum Gerat gehdrenden Anleitungen und bewahren Sie
diese auf.
» SchlieRen Sie die Anschlusskabel des Gerats nur an die dafir bestimmten
und fachgerecht installierten Anschlussdosen an

» Verwenden Sie ausschlieRlich Originalzubehér und Originalersatzteile.

Warnung: Unvollstédndige oder fehlerhafte Einrichtung kann zur
Gefahrdung von Personen flihren, z. B. aufgrund nicht durchfiihrbarer
Notrufe.

+ Die Einrichtung des Produkts erfolgt Uiber das Telefon oder iber die
Software COMfortel Set. Die zugehdrige Hilfe ist in englischer oder
deutscher Sprache vorhanden. Wenn Sie mit diesen Sprachen und den
verwendeten Fachbegriffen nicht vertraut sind, ziehen Sie eine fachlich
und sprachlich geeignete Fachkraft hinzu.

Warnung: In das Gehause eindringende Flissigkeiten kdnnen zu
einem lebensgefahrlichen elektrischen Schlag fihren und das Gerat
beschadigen oder zerstoren.
» Betreiben Sie das Telefon nur in geschlossenen, trockenen Raumen.
* Reinigen Sie das Gerat nur mit einem leicht feuchten Tuch oder einem
Antistatiktuch.

Warnung: Beschadigte Anschlussleitungen sowie Beschadigungen
am Geh&use und am Gerét selbst kénnen zu einem
lebensgefahrlichen elektrischen Schlag flhren.

* Nehmen Sie ein beschadigtes Gerat nicht in Betrieb.
Warnung: Uberspannungen, wie sie bei Gewitter auftreten, kénnen

zu einem lebensgefahrlichen elektrischen Schlag fuhren oder das
Gerat beschadigen oder zerstoren.

» Verzichten Sie wahrend eines Gewitters auf das Berlihren des Gerates.
» Lassen Sie von einer Elektrofachkraft alle Kabel innerhalb des Gebaudes
verlegen.
Warnung: Ungeeignete Headsets, externe Lautsprecher oder Horer
koénnen zu Gehdrschaden filhren oder die Sprachverbindung stéren.
» Beachten Sie die technischen Daten zum Anschluss eines Headsets.



Warnung: Durch das schwache Magnetfeld im Horer angezogene
Objekte wie Nadeln und Biroklammern kdnnen zu Verletzungen
fuhren.

* Legen Sie den Hérer nicht in die Nahe solcher Objekte.

Qé) Warnung: Erstickungsgefahr. Das Gerat enthalt Kleinteile, die von
QB Kleinkindern verschluckt werden kdnnen.

« Halten Sie das Gerat aul’erhalb der Reichweite von Kleinkindern

Wichtig: Das Geréat ist nicht dafiir ausgelegt und sollte daher nicht fur
lebenserhaltende Systeme und/oder Anwendungen innerhalb nuklearer
Einrichtungen eingesetzt werden. Einem Einsatz des Gerats fiir solche
Anwendungen muss zwingend eine auf den Einzelfall zugeschnittene
schriftliche Zustimmung/Erklarung des Herstellers vorausgehen.

Nicht bestimmungsgemafie Verwendung kann z. B. zu
Funktionseinschrankungen oder Stérungen, zur Zerstérung des Gerats oder
schlimmstenfalls zur Gefahrdung von Personen flhren.

» Wenn Sie sich Uber die bestimmungsgemafe Verwendung auch nach
dem Lesen des folgenden Kapitels nicht sicher sind, fragen Sie lhren
Fachhandler.

* Lesen Sie die zum Gerat gehdrenden Anleitungen und bewahren Sie
diese zum spateren Gebrauch auf.

« Fur die Nutzung einiger Funktionen ist eine Softwareerweiterung
(Freischaltung), eine Freischaltung beim Netzbetreiber, ein Firmware-
Update und/oder eine Einrichtung tiber COMfortel Set notwendig.

BestimmungsgemaiRe Verwendung

Systemtelefon zum Anschluss an den internen Sy- oder Upg-Port einer TK-
Anlage von Auerswald/FONtevo (siehe Technische Daten). Der Anschluss an
eine TK-Anlage eines anderen Herstellers oder an den externen Sy-Anschluss
eines Netzbetreibers ist nicht vorgesehen. Das Telefon ist schnurgebunden
und fiir den Betrieb in geschlossenen, trockenen Rdumen vorgesehen.

Technische Daten

Betriebsspannung | Versorgung Uber internen Sp- oder Upg-Port aus der
TK-Anlage

Leistungsaufnahme |Min. 1,1 W, max. 2,0 W

Systemanschluss Interner Sgy- oder Upp-Port der TK-Anlagen:
COMpact 3000 analog/ISDN/VolP, COMpact 2206
USB, COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R,
COMmander 6000/R/RX. COMmander Basic 2/19",
COMmander Business/19"

Speicher Micro-SD-/SDHC-Karte, 8 GB (empfohlen, nicht im
Lieferumfang)




Anzeigen 14 LEDs, 10 davon mehrfarbig, 3,5 Zoll-TFT-
Farbdisplay, 320 x 240 Pixel,
Hintergrundbeleuchtung

Bedienelemente Wahltastatur, 13 Festfunktionstasten, Farbdisplay mit
Touch-Funktion, Steuerkreuz, 10 programmierbare
Funktionstasten mit LED (mit jeweils bis zu zwei
Funktionen auf zwei Ebenen belegbar), weitere
Touch-Funktionstasten auf dem Display

Hoérer Wideband Audio, Elektret-Mikrofon, dynamischer
Hérerlautsprecher, hérgeratekompatibel

Headset Separate Schnittstelle fir dynamische Headsets

Gabelumschalter Magnetischer Schaltkontakt

Gehause Kunststoff, schwarz

Abmessungen 223 mm x 148/158/168 mm x 185 mm (B x H x T)

Gewicht Ca. 98049

Temperatur Betrieb: 0 bis 40 °C, Lagerung: - 30 bis + 70 °C, nicht
kondensierend

Sicherheit CE

Technische Daten fiir den Anschluss eines Headsets

Stromaufnahme Mikrofon Max. 0,5 mA
Empfindlichkeit Mikrofon -45dB

Impedanz Lautsprecher 150 Ohm
Empfindlichkeit Lautsprecher bei 1 kHz 19,5 +/- 3 dBPa/V
Schallpegelgrenze 24 dBPa

Umwelthinweise

Sollte das Gerat einmal ausgedient haben, achten Sie auf die fachgerechte
Entsorgung (nicht in den normalen Hausmdill).

&y Entsorgen Sie das Verpackungsmaterial im Interesse des
%69 Umweltschutzes ordnungsgeman.

Erkundigen Sie sich bei der Stadt- oder Gemeindeverwaltung nach
Méoglichkeiten einer umwelt- und sachgerechten Entsorgung des Gerats.
Wenn Sie mochten, dass wir Ihnen die Entsorgung abnehmen, senden
Sie das Gerat auf Ihre Kosten an die Auerswald GmbH & Co. KG.

Konformitatserkldrung

Dieses Gerat entspricht den grundlegenden Gesundheits-, Sicherheits- und
Umweltanforderungen aller relevanten europaischen Richtlinien. Die
Konformitatserklarung kann im Internet eingesehen werden.



Garantiebedingungen

1. Die Auerswald GmbH & Co. KG, Vor den Grashdfen 1, 38162 Cremlingen, Germany, gewahrt als Hersteller auf
dieses Produkt 24 Monate Herstellergarantie ab Kaufdatum.

2. Dies bedeutet fiir Sie als Verbraucher: Wir garantieren, dass unsere Geréte bei der Ubergabe fehlerfrei sind und
sorgen 24 Monate ab diesem Datum fiir eine kostenlose Reparatur oder liefern kostenfrei Ersatz, falls ein
Herstellungsfehler auftritt und verzichten auf den durch Sie als Verbraucher zu fiihrenden Nachweis wie bei der
gesetzlichen Gewahrleistung, dass dieser Fehler zum Zeitpunkt der Ubergabe schon vorhanden war. Bei der
Reparatur oder der Ersatzlieferung verwenden wir entweder neue oder neuwertige Teile. Dem Gerét evtl.
entnommene Teile gehen in unser Eigentum Uber und durfen vernichtet werden.

3. Neben dieser Garantie stehen dem Kunden in vollem Umfang die gesetzlichen Rechte aus der
Mangelgewahrleistung auf der Grundlage des Kaufvertrages gegeniiber dem Lieferanten zu. Die gesetzliche
Mangelgewahrleistung betrifft aber im Gegensatz zu unserer Herstellergarantie nur die Beschaffenheit zum Zeitpunkt
des Verkaufs (Ubergabe).

4. Sie kénnen diese Garantie nur in Anspruch nehmen, wenn Sie das fehlerhafte Gerat mit einem eindeutigen
Kaufbeleg (Rechnung oder Kassenbeleg) auf lhre Kosten an die Auerswald GmbH & Co. KG bzw. auBerhalb
Deutschlands an unseren Generalimporteur oder Distributor vor Ort einsenden. Fiigen Sie dieser Einsendung bitte
eine ausfiihrliche Fehlerbeschreibung bei und geben Sie bitte auch fiir eventuelle Nachfragen Ihre Telefonnummer an.
Um Transportschaden zu vermeiden, sorgen Sie bitte fiir eine geeignete Transportverpackung (z. B.
Originalverpackung mit Umkarton).

5. Ausgeschlossen von der Herstellergarantie sind Schaden, die durch unsachgemaRe Behandlung,
Bedienungsfehler, Missbrauch, duRere Einfliisse, Blitzschlag/Uberspannung, Veranderungen des Produkts sowie
Anbauten entstehen. Des Weiteren ausgeschlossen sind Verschleiteile (z. B. Batterien, Sicherungen, Akkus,
Speicherkarten), sowie durch Verschleilteile entstandene Schaden (z. B. durch das Auslaufen von Batterien).
Ebenfalls ausgeschlossen sind Transportschaden, Folgeschaden, Kosten fiir Ausfall- und Wegezeiten.

6. Die Garantie erlischt bei Reparaturen durch nicht autorisierte Stellen.

Erstinbetriebnahme
SchlieRen Sie das Telefon wie in der Abbildung unter Anschluss gezeigt an.

Ersteinrichtung tiber das Telefon
Voraussetzungen:

» An der TK-Anlage eingerichtete interne Rufnummer
Folgen Sie den Anweisungen im Telefon.

Hinweis: Die MSN ist die in der TK-Anlage eingerichtete interne
Rufhummer.

Einrichtung Giber COMfortel Set

Voraussetzungen:
» Java Runtime installiert (finden Sie auf unserer Internetseite)
+ COMfortel Set installiert (finden Sie auf unserer Internetseite)

» Bestehende Verbindung des PCs zu einer PC-Schnittstelle der TK-Anlage
(siehe Anleitung der TK-Anlage)

1. Starten Sie das Programm.

2. Wahlen Sie unter Optionen > Schnittstelle die von Ihnen verwendete
Schnittstelle aus (z. B. IP-Netzwerk bei Verbindung des PCs mit der TK-
Anlage Uber das lokale Netzwerk).

3. Klicken Sie auf Offnen > Telefon und wahlen Sie das betreffende Telefon
aus.

4. Geben Sie die PIN ein.



5. Nehmen Sie die gewtiinschten Einstellungen vor.

6. Sichern Sie die Konfiguration anschlieRend in das Telefon. Klicken Sie
dazu nacheinander auf Datei > Speichern > Telefon.



English

Important Information

Safety Information
Warning: Handling the device improperly can cause a life-threatening
electrical shock, or damage or destroy the device.
» Read the manuals for the device and keep them for future reference.

» Only connect the device's connection cables to wall sockets that are
designed for that purpose, and that have been properly installed.

» Only use original accessories and original replacement parts.
Warning: Incomplete or incorrect configuration can create a personal
hazard e.g. because emergency calls cannot be made.

» The product is configured using the telephone or the COMfortel Set
software. The associated help is provided in English or German. If you are
not familiar with these languages, and the technical terms that are used,
seek support from someone who has the necessary technical and
language skills.

Warning: Any liquid that penetrates the casing can result in a life-
threatening electric shock or can damage or destroy the telephone.

* Only operate the telephone in closed, dry rooms.

* Only clean the device with a soft damp cloth or an anti-static cloth.
Warning: Damaged connecting cables, or damage to the casing or
the device, can cause life-threatening electrical shocks.

» Never use a damaged device.

Warning: Power surges, which can occur during electrical storms,

can cause life-threatening electric shocks or damage/destroy the
device.

» Do not touch the device during an electrical storm.
» Arrange for a qualified electrician to install all the cables inside the building.
Warning: Non-approved headsets, external loudspeakers, or

receivers, may cause hearing damage or interfere with the voice
connection.

» Note the technical information about connecting a headset.
Warning: Objects attracted by the weak magnetic field in the receiver,
such as needles and paper clips, can cause injuries.
» To avoid injuries, do not put the receiver down close to such objects.
Qé) Warning: Danger of suffocation. The device contains small parts
& which infants or small children might swallow.
» Keep the device out of reach of children.



Important: The device is not designed or intended for use in life-support

systems and/or nuclear facilities. The device can only be used for these

purposes with prior written permission/clarification from the manufacturer in

each individual case.

Improper use may, for example, cause functional restrictions or

malfunctions, the destruction of the device or, in a worst case scenario,

personal injury.

« If you are still uncertain about how to use the product properly after reading
the section below, please contact your specialised dealer.

» Read the manuals for the device and keep them for future reference.

» Some of the functions require a software expansion (activation), activation
by the network provider, a firmware update and/or configuration via
COMfortel Set.

Proper Use

System telephone for connection to the internal Sy or Upg port on a PBX
supplied by Auerswald/FONtevo (see Technical Data). There is no provision for
connecting to another manufacturer's PBX or to a network provider's external
Sy connection. The telephone is corded, and is intended for use in closed, dry
rooms.

Technical Data
Operating voltage |Power from the PBX via the internal Sy or Upq port

Power Min. 1.1 W, max. 2.0 W
consumption

System connection | Internal Sy port or Upg port from one of the following
PBXs: COMpact 3000 analog/ISDN/VolP,

COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Memory Micro SD/SDHC card, 8 GB (recommended, not in
the scope of delivery)

Displays 14 LEDs, 10 are polychromatic. 3.5" TFT colour
display, 320 x 240 pixels, backlight
User elements Keypad, 13 permanently assigned function keys,

colour display with touch operation, directional pad,
10 programmable function keys with LEDs (on which
up to two functions can be assigned on two levels),
additional touch function keys on the display

Receiver Wideband audio, electret microphone, dynamic
receiver loudspeaker, hearing aid compatible

Headset Separate interface for dynamic headsets



Hook key Magnetic switch contact

Casing Plastic material, black

Dimensions 223 mm x 148/158/168 mm x 185 mm (W x H x D)

Weight Approx. 980 g

Temperature Operation: 0 to 40 °C, storage: - 30 to + 70 °C, non-
condensing

Security CE

Technical Data for Headset Connections

Microphone current consumption Max. 0.5 mA
Microphone sensitivity -45dB
Loudspeaker impedance 150 Ohm
Loudspeaker sensitivity at 1 kHz 19.5 +/- 3 dBPa/V
Sound level threshold 24 dBPa

Environmental Notices

If you want to dispose of the device, please ensure its professional disposal.
Do not put it in the normal household waste.

&y Dispose of the packaging material properly and in interest of the
%9 environmental protection.

Consult your responsible authority for information about the professional
and environment-friendly disposal of your device. If you want that we
handle the disposal for you, you can send the device at your costs to
Auerswald GmbH & Co. KG.

Declaration of Conformity

This device complies with the basic health, safety and environmental
requirements in all relevant EU directives. You can view the Declaration of
Conformity on the Internet.

Conditions of Warranty

1. Auerswald GmbH & Co. KG, Vor den Grashdfen 1, 38162 Cremlingen, Germany, grants 24 months Manufacturer's
Warranty from the date of purchase, as the manufacturer of this product.

2. For you, as a consumer, this means: We guarantee that our devices are error-free when supplied. If a manufacturing
error is identified within 24 months of the delivery date we will repair or replace the device free of charge without you,
as the consumer, having to provide the usual legally required proof that this fault was present when you received the
device. We either use new parts or parts in mint condition for the repair or replacement delivery. Any parts removed

from the device become our property and can be destroyed by us.

3. In addition to this warranty, you have the unlimited legal right to claim against the supplier on the basis of the terms
of the warranty for defects on the basis of the purchase contract. However, in contrast to our Manufacturer's Warranty,
the legal warranty for defects only applies to the device's state when sold (handover).

4. You can only claim against this warranty if you return the faulty device to Auerswald GmbH & Co. KG or our local

general importer or distributor, outside Germany, at your own cost, with a valid proof of purchase (invoice or till receipt).
When you return it to us, please provide a detailed description of the fault that has occurred, and also tell us your



telephone number, in case we need to contact you. To prevent shipping damage, provide suitable transport packaging
(e.g. original packaging with a secondary shipping box).

5. The Manufacturer's Warranty excludes damage caused by mishandling, operating errors, misuse, external
influences, lightning strikes/power surges, modifications to the product and extensions. Also excluded are wearing
parts (e.g. batteries, fuses, rechargeable batteries and memory cards) and damage caused by wearing parts (e.g. if
batteries go flat). Shipping damage, consequential damage, and costs arising from down times and travel times are
also excluded.

6. The warranty is cancelled if repairs are carried out by unauthorised agents.

Initial Commissioning
Connect the telephone as shown in the figure under Connection.

Initial Setup using the Telephone

Requirements:

* Internal telephone numbers configured on the PBX
Follow the instructions on the telephone.

Note: The MSN is the internal number that has been set up on the PBX.

Configuration via COMfortel Set

Requirements:

» Java Runtime is installed (available on our website)

+ COMfortel Set is installed (available on our website)

+ Existing PC connection to a PC interface on the PBX (see the PBX manual)

1. Run the program.

2. Select Options > Interface and then select the interface you are using (for
example, IP network, to connect the PC to the PBX over the local
network).

Click Open > Telephone and select the required telephone.
Enter the required PIN.
Configure the settings you want.

Now save the configuration in the telephone. Click File > Save >
Telephone.

ook w



Espanol

Informacién importante

Indicaciones de seguridad

Advertencia: Si este dispositivo se utiliza de forma indebida se corre
el riesgo de provocar una descarga eléctrica potencialmente mortal y
dafos en el dispositivo o su destruccion.

» Debe leer las instrucciones correspondientes al dispositivo y guardarlas.

* Los cables de conexién del dispositivo deben conectarse Unicamente a las
cajas de conexion instaladas especificamente para ellos

« Utilice exclusivamente repuestos y accesorios originales.

Advertencia: La configuracion incompleta o errénea del sistema
puede poner en riesgo a las personas, como en el caso de que no se
puedan realizar llamadas de emergencia.

* La configuracioén del producto se efectua a través del teléfono o del
software COMfortel Set. La ayuda correspondiente esta disponible en
inglés y en aleman. Si no tiene un dominio suficiente de estos idiomas ni
de la terminologia técnica solicite ayuda a un profesional técnico que
conozca dichos idiomas.

Advertencia: La penetracion de liquidos en el interior de la carcasa
puede provocar una descarga eléctrica potencialmente mortal y dafar
o destruir el dispositivo.

 El teléfono solamente puede funcionar en espacios cerrados y secos.

» Para limpiar el dispositivo utilice Unicamente un pafio humedecido o un
pafio especial antiestatico.

Advertencia: Las lineas de conexion dafiadas, asi como los dafnos o
desperfectos en la carcasa o el propio dispositivo, pueden provocar
descargas eléctricas potencialmente mortales.
» Jamas debe encender un dispositivo averiado o dafiado para hacerlo
funcionar.

Advertencia: Las sobretensiones, como las que pueden producirse
en caso de tormenta eléctrica, pueden provocar descargas eléctricas
potencialmente mortales y dafiar o destruir el dispositivo.
» No toque el dispositivo durante una tormenta eléctrica.
» Debe encargar a un electricista el tendido de todos los cables en el interior
del edificio.

Advertencia: El uso de auriculares, altavoces externos o
microteléfonos inadecuados puede provocar dafios en el oido o
dificultar la comunicacion.

» Consulte los datos técnicos antes de conectar unos auriculares.



Advertencia: El campo magnético de baja intensidad del
microteléfono puede atraer objetos de oficina como chinchetas o clips
que pueden provocar lesiones.

* No deje el microteléfono cerca de dichos objetos.

Advertencia: Peligro de asfixia. Este dispositivo contiene piezas
QB pequefas que podrian ser ingeridas por nifios pequefos.
* Mantenga el dispositivo fuera del alcance de los nifios pequefios

Importante: Este dispositivo no se ha concebido para trabajar con sistemas
de soporte vital o aplicaciones relacionadas con instalaciones nucleares, por
lo que no se debe utilizar para tales fines. Si se pretende utilizar este
dispositivo para finalidades de esa naturaleza, es obligatorio contar con una
autorizacion o aprobacion previa por escrito del fabricante que se adapte a
las caracteristicas concretas del caso.

Utilizar este dispositivo para fines distintos de los previstos podria conllevar
limitaciones de su funcionamiento o averias y destruir el dispositivo o, en el
peor de los casos, comportar riesgos para la seguridad de las personas.

» Sidespués de leer el siguiente capitulo le quedan dudas sobre el uso
adecuado y previsto del dispositivo consulte a su distribuidor
especializado.

» Debe leer las instrucciones correspondientes al dispositivo y guardarlas
para poderlas consultar posteriormente.

» Para usar algunas funciones es preciso instalar una ampliacion del
software (activandola), efectuar una activacién en el operador de red, una
actualizacion del firmware y/o ejecutar una configuracién con el software
COMfortel Set.

Uso previsto

Teléfono de sistema para conexion al puerto interno Sy 0 Upg de una centralita
de Auerswald/FONtevo (ver datos técnicos). No esta prevista la conexion a
una centralita de otro fabricante ni a la conexion externa Sy de un operador de
red. El teléfono con cable esta previsto para funcionar en espacios cerrados y
secos.

Datos técnicos

Tension de Alimentacion a través del puerto interno Sy o Upg de
servicio la centralita

Potencia Min. 1,1 W, max. 2,0 W

absorbida

Conexion del Puerto interno Sy o Upg de las centralitas:

sistema COMpact 3000 analdgica/RDSI/VolP,

COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"




Memoria Tarjeta micro SD/SDHC, 8 GB (recomendada, no
incluida)

Indicadores 14 LED, 10 de ellos de varios colores; pantalla a color
TFT de 3,5 pulgadas, 320 x 240 pixeles,
retroiluminacion

Elementos de Teclado de marcado, 13 teclas con funciones fijas,
mando pantalla a color con funcion tactil, pad de control, 10
teclas de funcién programables con LED (se les
puede asignar hasta dos funciones a cada una en
dos niveles) y otras teclas de funcion tactiles en la

pantalla

Microteléfono Audio de banda ancha, micréfono electret, altavoces
dinamicos, compatible con audifonos

Auriculares Interfaz independiente para auriculares dinamicos

Gancho Contacto de maniobra magnético

conmutador

Carcasa Plastico, negro

Dimensiones 223 mm x 148/158/168 mm x 185 mm (an x al x f)

Peso Aprox. 980 g

Temperatura Funcionamiento: De 0 a 40 °C, almacenamiento: De
-30a+ 70 °C, sin condensacion

Seguridad CE

Datos técnicos para la conexién de auriculares

Consumo de potencia micréfono Max. 0,5 mA
Sensibilidad micréfono -45dB
Impedancia altavoz 150 ohmios
Sensibilidad altavoz a 1 kHz 19,5 +/- 3 dBPa/V
Limite de nivel sonoro 24 dBPa

Indicaciones relativas al medio ambiente

Si el dispositivo se queda anticuado o finaliza su cometido, debe tener en
cuenta las normas especificas para la eliminacion del mismo (no se debe
desechar junto con la basura doméstica).

&y Elimine el material de embalaje conforme a las normas de proteccion del
medio ambiente.

Consulte al 6rgano de administracién municipal cuales son las
posibilidades para desechar el dispositivo de una forma adecuada y
respetuosa con el medio ambiente. Si lo desea, nosotros podemos



hacernos cargo de la eliminacién. En tal caso, envie el dispositivo a Auerswald
GmbH & Co KG. Debera correr con los gastos de envio pertinentes.

Declaraciéon de conformidad

Este dispositivo cumple con los requisitos esenciales sobre salud, seguridad y
medio ambiente de todas las directivas europeas pertinentes. La declaracion
de conformidad se puede consultar en Internet.

Condiciones de la garantia

1. La empresa Auerswald GmbH & Co. KG, con sede en Vor den Grashodfen 1, 38162 Cremlingen, Germany, como
fabricante de este producto, ofrece una garantia de fabricante por un plazo de 24 meses, contados desde la fecha de
compra.

2. Para usted, como consumidor, esto implica que: Le garantizamos que nuestros dispositivos estan en perfecto
estado de funcionamiento en el momento de la entrega. Durante un plazo de 24 meses a partir de esa fecha, en caso
de defectos de fabricacion, le proporcionaremos un servicio de reparacion totalmente gratuito o le facilitaremos un
aparato de sustitucion sin coste. A diferencia de las condiciones de la garantia legal obligatoria, usted no tendra que
demostrar que el problema o la averia ya existia en el momento de la entrega de la centralita. En caso de que sea
preciso realizar reparaciones o entregarle un dispositivo de sustitucion, utilizaremos componentes nuevos o en
perfecto estado. Los componentes que pudieran extraerse del dispositivo pasaran a ser de nuestra propiedad,
estando permitida su destruccién.

3. Ademas de esta garantia, el cliente cuenta con todos los derechos legales derivados de la garantia contra defectos
impuesta por ley, que descansan sobre el contrato de compraventa y cuyas responsabilidades recaen sobre el
proveedor. A diferencia de nuestra garantia de fabricante, la garantia legal contra defectos solamente cubre las
condiciones del producto en el momento de la venta (entrega).

4. Solamente podra efectuar reclamaciones al amparo de esta garantia si acomparia el dispositivo defectuoso de un
documento que acredite con claridad la adquisicion (factura o recibo de compra), que debe presentar corriendo usted
con los correspondientes gastos ante Auerswald GmbH & Co. KG o, en caso de encontrarse fuera de Alemania, ante
nuestro importador general o distribuidor local. Le rogamos que, junto con el dispositivo y la documentacion
acreditativa de la compra, incluya una descripcion detallada del problema y nos facilite asimismo un nimero de
teléfono para poder plantearle las preguntas que pudiesen surgir. Para evitar que el dispositivo sufra dafios durante
el transporte, le aconsejamos que procure emplear un embalaje apropiado para ello (por ejemplo, el embalaje original
dentro de una caja protectora).

5. Quedan excluidos de la garantia del fabricante los dafios causados por manipulacién inadecuada, errores de
manejo, usos indebidos, factores externos, sobretensiones o impactos de rayos, alteraciones del producto o
accesorios complementarios incorporados. Quedan asimismo excluidos de la garantia los componentes sometidos a
desgaste (por ejemplo: pilas, fusibles, baterias, tarjetas de memoria) y los dafios provocados por componentes
sometidos a desgaste (por ejemplo, por pilas agotadas). También quedan excluidos de la garantia los dafios ocurridos
durante el transporte, los dafios indirectos y los costes por interrupciones del servicio y tiempos de los traslados.

6. La garantia se considerara extinguida si se efecttian reparaciones en talleres no autorizados.

Entrada en servicio

Realice las conexiones del teléfono como se muestra en la figura titulada
"Conexién".

Configuracion inicial a través del teléfono
Requisitos:

* Numero interno configurado en la centralita
Siga las instrucciones del teléfono.

Nota: El MSN es el numero interno configurado en la centralita.




Configuracion a través COMfortel Set

Requisitos:

+ Java Runtime instalado (lo encontrara en nuestra pagina web)
+ COMfortel Set instalado (lo encontrara en nuestra pagina web)

» Conexion establecida entre el PC y una interfaz PC de la centralita (véanse
las instrucciones de la centralita)

-

Inicie el programa.

2. En Opciones > Interfaz seleccione la interfaz que utiliza (p. ej. Red IP
para la conexién del PC con la centralita a través de la red local).

3. Haga clic en Abrir > Teléfono y seleccione el teléfono que corresponda.

4. Introduzca el PIN.

5. Realice los ajustes deseados.

6. Acto seguido guarde la configuracién en el teléfono. Para ello haga clic

sucesivamente en Fichero > Guardar > Teléfono.



EAANvIKaG

ZNMAVTIKEG TTANPOPOPIES

Ymodeieig acpaleiag

Mpoeidotroinon: H akatdAANAn xprion TNG CUOKEUNG UTTOPET va
odnynoel ag Bavatn@opo nAekTpoTTANSia Kai va TTPOKAAETEl CnNUIEG N
VA KOTOOTPEWE TN CUOKEUN.

* AloBdoTe TIg 0dnyieg XpAONG TTOU OUVOBEUOUV T GUCKEUN KOl QUAGETE TIG.

* 2uvdéeTe TO KOAWDIO OUVOEONG TNG CUOKEUNG MOVO OTIG OXETIKA
TTPORAETTOUEVEG KOl CWOTA TOTTOBETNUEVEG TTPICES
» XpnOIYOTIOIEITE ATTOKAEIOTIKG YV OIQ EEAPTIAPATA KAl AVTOAAGKTIKA.

Mpoegidotroinon: H eANITTG 1} ec@aApévn puBuIon evdéxeTal va BEoEl
o€ KivOuvo dtopa, TT. X. AOyw pn eKTEAECIUWY KANOEWV EKTAKTNG
avAaykng.
* H puBuion Tou TTPOIdVTOG TTPAYUATOTIOIEITAI JECW TOU TNAEPWVOU I HECW
Tou Aoyiopikou COMfortel Set. H oxetikr BorBeia diaTiBeTal aTnv ayyAIkn
1l 0TN YePUaVIKA YAWOoa. Av Ogv €i0TE ECOIKEIWPEVOI PUE QUTEG TIG YAWOOEG
KQI TOUG XPNOIUOTTOIOUUEVOUG €I0IKOUG OPOUG, CUMBOUAEUTEITE TEXVIKA KOl
YAWGOIK& KATAAANAO €EEIBIKEUUEVO TTPOCWTTIKO.

Mposidotroinon: H eioxwpnon uypwv aTto TTEPIBANU UTTOPET va
odnynoel ag Bavatn@opo nAekTpoTTANSia Kai va TTPOKAAETEl CnNUIEG N
VA KOTOOTPEWE TN CUOKEUN.
» AeiToupyeite To TNAEQPWVO POvVo o€ KAEIOTOUG, ENPoUg XWPOoug.
» KaBapilete TN ocuokeur) Hovo pe EAA@PWG BPeyUEVO TTAVI 1) JE AVTIOTATIKO
TTavi.

Mposidotroinon: KareaTpappéva KaAwdia, Kabwg kail {nuIEG GTO
TePIBANMa Kal Tnv idla TN CuoKeu UTTOPoUV va odnyroouV o€
Bavatneopo nAekTpoTTANnEia.

* Mnv B€T€TE O€ AcITOUPYIQ WO KATECTPAUUEVN CUOKEUN.

Mpo&idotroinon: O utreptdoeig TTou cupPaivouv katd Tn didpkeia
KATalyidwyv UTTopouv va TTpoKaAéoouv Bavatn@opo nAekTpoTTAngia kai
va TTPOKOAEOOUV CNUIEG i} VO KATAOTPEWOUV T CUCKEUN).
* ATTOQEUYETE KOTA TN IAPKEIQ KATAIYiIOWY TNV ETTAPA UE TN CUCKEUN.
» AvabéoTte o€ €vav £€eIdIkeuPEVO NAEKTPOAGYO va TOTTOBETHOEI OAa TO
KaAwdia evTdg TOU KTIpiou.

Mpoe&idotroinon: AKatdAANAa CET AKOUCTIKWY, EEWTEPIKA Nxeia
QaKOUOTIKG UTTopoUv va odnynoouv o€ BAGREG oTnv akor f va
TTPOKOAéOOUV TTOPEPPBOAEG OTN TUVOETN GUVOMIAIGG.

* Tnpeite Ta TEXVIKA OTOIXEIQ YIO TN OUVOECN OET OKOUCTIKWV.



Mpo&idotroinon: Adyw Tou agBevoUg payvnTikou TTeEdiou oTo
QKOUOTIKO TO QVTIKEIJEVA TTOU TTPOCEAKUOVTAI, OTTWG BEAOVEG Kal
OUVOETAPEG, NTTOPOUV Va 0BNYyrROOUV G€ TPAUUATIONOUG.

* Mnv TOTTOBETEITE TO AKOUOTIKO KOVTA O€ TETOIOU €iOOUG AVTIKEIUEVA.

Mposidotroinon: Kivduvog acguéiag. H ouokeur] TTEPIEXET MIKPA
QB KOMMATIO PE KivOUVO KOTATTOONG ATTO MIKPA TTaidId.

* QUAAOOETE TN OCUOKEUN PAKPIG AT PIKPA TTaIdId

ZnpavTiko: H ouokeur] Oev £xel oXeOIOOTEN KAl OV TTPETTEI ETTOUEVWG VA
XPNOIYOTIOIEITAI O€ CUCTANATA /KOl EQAPHOYEG UTTOCGTAPIENG {WTIKWV
AerToupylwyv péoa o€ TTUPNVIKEG EyKaTaoTAoelg. Mpiv atd Tn xprion g
OUOKEUNG O€ TETOIEG EQAPHOYEG Ba TTPETTEI VA TTPONYEITAI UTTOXPEWTIKA Hia
TTPOCOPUOCUEVN OTN CUYKEKPIMEVN TTEQITITWON £yypagn cuykaTtdbeon/
OnAwWaoN TOU KATAOKEUQOTH).

H pn TpoBAeTTOUEVN XPrION UTTOPET VA 0BNYNOEL, TT. X. O€ AEITOUPYIKOUG

TTEPIOPIOPOUG I BIOTAPAXEG, OTNV KATACTPOPHA TNG CUCKEUNG ) OTN XEIPOTEPN

TTEPITITWON OTOV TPAUUATIONO ATOHWV.

* Av dev gioTe BEBaiol yia TNV TTPORAETTOMEVN XPAON AKOPA KOl JETA TNV
avAayvwan ToU ETTOPEVOU KEQAAQiIOU, pwTOTE TOV eEEIOIKEUPEVO EUTTOPO
gag.

» AloBdoTe TIg 0dnyieg XpAONG TTOU OUVOBEUOUV TN GUOKEUTN KAl QUAGETE TIG
yia JEANOVTIKA Xprion.

* [1a ™ Xprion opIoHEVWV AEITOUPYIWY ATTAITEITAI ETTEKTACN AOYIOUIKOU
(evepyoTroinan), evepyoTroinon aTov PopEa EKUETAAAEUONG, EVNUEPWON
UNIKOAoYIoHIKOU f/kal puBuion péow tou COMfortel Set.

MpoBAetrépevn xpnon

TnAépwvo ouoTAPATOG YIa OUVOEDT) OTNV ECWTEPIKN BUpa Sy 1 BUpa Upq evog
TNAEQWVIKoU Kkévtpou Tng Auerswald/FONtevo (BAETTE TEXVIKG OTOIXEIQ). Agv
TIPOBAETTETAI N OUVOEDN O€ £va TNAEPWVIKO KEVTPO KATTOIOU GAAOU
KOTAOKEUAOTN 1 0NV eEWTEPIKA oUvdeon Sy evog popéa ekpeTdAAeuong. To
TNAEQWVO gival eEvoUpUATO Kal TTpoopideTal yia AsiIToupyia o€ KAEIoTOUG, Enpolg
XWPOUG.

Texvikd oToixeia

Taon Aeitoupyiag | Tpopodoaia péow eowTepIKrg BUpag Sy 1 Upg atrod
TO TNAEQWVIKS KEVTPO

KartavaAwon EAax. 1,1 W, péy. 2,0 W

1oxU0g

>uvdeon Eowrtepikr B0pa Sy i UpgTwV TNAEPWVIKWYV KEVTPWV:
OUCTANATOG COMpact 3000 avaAloyiké/ISDN/VolP,

COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"




ATtroBAkeuon Kdpta Micro-SD/SDHC 8 GB (ouviotdral, dev
mepIAapBaveTal aTa TTapadoTéa)
MpoBoAnR 14 Auyvieg LED, 10 amré autég TTOAUXPWHEG,

£yxpwpn 0066vn 3,5 ivtowv TFT, 320 x 240 pixel,
PWTIOPOG PpbVTOU

ZTOIXEIO XEIPIOUOU

MAnkTPOAdyIO eTTIAOYNG apIBuwy, 13 TTANKTPa
oTaBepng Asitoupyiag, £yxpwun 086vn pe Asitoupyia
a@ng, TTANKTPoAAyIo kKARang, 10 TrpoypappaTifopeva
TAAKTPa AsiToupyiag pe Auyvia LED (duvatotnTa
QvTIOTOIXIONG €WG Kal dUO AsiToupyieg o€ dUO
€mMTEdQ), TTEPAITEPW TTAAKTPA AEITOUPYIAG APAG OTNV
0086vn

AKouoTIKO

Wideband audio, pikpégwvo Elektret, duvapikéd nxeio
OKOUGTIKOU, OUMPBATO PE OKOUOTIKEG OUOKEUEG

2 €T OKOUOTIKWYV

ZeXWPIOTEG BUPEG yIa SUVOUIKG OET AKOUGTIKWV

AloKOTITNG MayvnTikA emTa@n d1oKOTTN

QayKioTpou

MepiBAnua MAaoTikd, pavpo

AiaoTdoeig 223 mm x 148/158/168 mm x 185 mm (M x Y x B)

Bapog Mep. 980 g

O¢puokpacia Aermoupyia: 0 éwg 40 °C, amoBrikeuon: - 30 £éwg
70 °C, xwpig oupTtrukvwon

Ac@dAcia CE

Texvikd oToIXEia Yia T OUVSECT EVOG OET OKOUOTIKWV

KatavaAwaon 1ax00G hHIKPOPWVOU Méy. 0,5 mA
EuvaioBnaoia pikpogpwvou -45dB
AvTioTaon nxeiou 150 Ohm
EuvaioBnaoia nxeiou o€ 1 kHz 19,5 +/- 3 dBPa/V
Opia atdBbung rixou 24 dBPa

MNepiBalAovTikég utrodEigelg

>¢ TTEPITITWON TTOU N GUOKEUR CUPTTANPWOEl TNV wPEAIUN didpkeia {wng Tng,
@povTioTe yia TNV KAaTt@AANAN amméppiyn (6x1 padi pe Ta ouvren oikiakd

atroppiypaTa).

&y AtroppiyTe To UAIKO OUOKEUOOIOG 0woTd, PPOVTICOVTAG YId ThV
%@ TTpooTacia Tou TTEPIBAAAOVTOG.
MAnpo@opnBeite atrd Tn dNUOTIKNA 1 TOTTIKN apxn yia TIG duvaTtdTnTEG
OWOTAG KAl GIAIKAG TTPOG TO TTEPIBAAAOV aTTOPPIWYNG TNG OUCKEUNG. Av



B¢éAeTe va avaAdBoupe epeic TNV amdppiyn, OTEIATE TN CUCKEUN Gag Pe OIKr oag
empapuvon otnv Auerswald GmbH & Co. KG.

AARAwon cuppdéppwong

AUTA N CUCKEUN CUUUOPQWVETAI JE TIG BACIKEG ATTAITATEIS UYEIag, ac@aAeiag
Kal TTEPIBAAAOVTOG OAWV TWV OXETIKWYV EUPWTTAIKWY 0dnyIwv. MTTopeiTe va
ocite TN dAWON CUPPOPPWONG GTO BIAdIKTUO.

Opol Tapoxng eyyonong

1. H Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, TTapéxel WG KATAOKEUAOTAG
auToU ToU TTPOIBVTOG £yyUNON KATAOKEUAOTH 24 unvwy atré TNV nuepopnvia ayopdg.

2. MNa €066 wg KatavaAwTh autd onpaivel: EyyudpaoTe 6T 01 GUOKEUEG pag €ival aTTaAAayUEVEG aTTd OPAApaTA KATA
TNV Tapdadoon kai Eac@aiifoupe 24 priveg atré auTAv TNV NUEPOUNVia dwpedv ETTIOKEUN i} dwPEAV avTIKATAOTAON, OE
TTEPITITWON OPAAPATOG KATAOKEUNG Kal TTApaiToUUacTe OTT TO ATTOJEIKTIKG TTOU TTPETTEI va UTTORANBET atmd €0GG WG
KATAVOAWTH, CUPQWVA HE T VOUIUN €yyUnon, OXETIKG WE TO OTI aUT TO OQAAUA UTTAPXE BN TO XPOVIKG anuEio NG
TTapddoong. Kartd tnv eTmoKeun i TRV TTapddoon TN aVTIKATAGTAONG XPNOIMOTIOIOUNE EiTE KAIVOUPYIX EiTE
QAVOKATAOKEUAOPEVA PEPN. Ta péPN TTOU eVOEXOUEVWG Ba apaipeBoUv aTrd T GUCKEUN TTEPVOUV OTNV IBIOKTNTIa Pag
Kal EMTPETTETAI VO KATAOTPAPOUV.

3. EKT6G 0116 TNV TrapoUoa £yyUnaon o TTEAGTNG SiKaiouTal TTARPWS Ta VOUIPA SIKAIWPATA, OTTWG TTPOKUTITOUV atrd TNV
eyyunon Tepi eAaTTwpdTWY Baoel TNG cUPPBAONG ayopdg aTrévavTi oTov TTPounBeuTh. H vopiun eyyunon mepi
EAATTWPATWY aPopd WOTEOO O€ avTiBeon Ye Tn JIKN Pag £yyUNan KATAOKEUAOTH HOVO TNV KATAOTAOT KOTE TO XPOVIKO
onpeio Tng TWANong (Trapddoon).

4. MTopeiTe va eTw@eAnBeiTe TNG TTAPOUTAG £yyUNONG HOVO AV OTEIAETE TNV EAQTTWHATIKA GUOKEUN padi Ye ia oogn
atrodeIgn ayopdg (TiHoAdyIo 1) amddeign) pe dikd oag £goda oTnv Auerswald GmbH & Co. KG 1} ek1dg Meppaviag oe
SIKO HOG YEVIKO €l0aywYEa i} TOTTIKG Slavopéa. ZTnV atrooToAr) CUUTIEPIAGBETE AETITOPEPT TIEPIYPAPT) TOU TOAAPATOG
KOl ONAWOTE Kal TOV apiBud TNAEPWIVOU GG YIa EVOEXOPEVEG TIEPAITEPW EPWTATEIG. [ va aTTo@UyETE {NUIEG KATA TN
HETAQOPA, XPNOINOTIOINOTE KATAAANAN CUCKEUATia HETAPOPAG (TT. X. N ApXIKr) CUOKEUAoia Hadi pe EEWTEPIKO XapTOVI).
5. A6 Tnv gyyUnon KataokeuaaoTr e§aipolvTal ol {nUIEG TTou TTpokaAoUvTal atrd akaTdAANAO XEIpIoPO, T@GApaTa
XEIPIOPOU, ECQaAPEVN XPAON, ESWTEPIKEG ETTIPPOEG, AOTPATTEG/UTTEPTACT, HETATPOTTEG OTO TTPOIGV, KABWGS Kal
€TTeKkTAOEIG. ETNITTALOV, €€aipouvTal Ta e§apTApaTa @BOPAG (T1. X. HTTATAPIES, ACPAAEIEG, CUCOWPEUTEG, KAPTEG
aTToBAKEUONG), KABWG Kal oI {NUIEG TTOU TTPOKAAOUVTAI OTTO £E0PTANATA POOPAG (TT.X. AGYw dIapPORG TWV UTTATAPIWY).
Emiong, eSaipoUvTal o1 nuiég KaTd TN HETAPOPG, Of ETTAKOAOUBEG CNHIEG, Ta KOOTN ACTOXIWY Kal TwV dIaoTNUATWY
HETAKIVAOEWV.

6. H gyyOnon mradel va 10xUel 6TaV Ol ETTIOKEUEG EKTEAOUVTAI aTTO WN £€ouciodoTnuéva dToua.

MpwTtn 0éon o€ AsiToupyia
>uvdEéaTe To TNAEQWVO, OTTWG EPPAVICETaI TNV EIKOVA Yia Th oUVOEDN.

ApXIKA pUBHION oW TOU TNAEPWVOU

MpoUTtobéaeig:

* XTOV EOWTEPIKO apIBUG KARONG TTOU €XEl PUBUIOTEI OTO TNAEPWVIKO KEVTPO
AkoAouBnaTe TIG 0BNYieg XPATEIG OTO TNAEPWVO.

Ymwodei§n: To MSN eival o eowTepIkdg apIBPOG KAAONG TTou €xel puBUIOTEI
OTO TNAEQWVIKO KEVTPO.

PuOuion péow Tou COMfortel Set

MpouTrobéoeig:

» To Java Runtime éxel eykataaTaBei (BA. OXETIKA GTOV IGTOTOTTO PAG)
+ To COMfortel Set €xel eykataoTabei (BA. OXETIKG OTOV IOTOTOTIO HAG)



* Ymdpxouaa oUvdeon Tou UTTOAOYIOTH O€ Jia BUpa uTToAOyIOTH TOU
TNAEQWVIKOU KEVTPOU (BAETTE 0dNYiEg XPrIoNG TOU TNAEPWVIKOU KEVTPOU)

1.  EkkivAoTe 1O TTpdYpOUUA.

2. EmA&CTe oto EmiAoyég> Alaouvdeon TIG XpNOIUOTIOIOUEVEG OTTO £0GG
B0peg (11. X. AikTuo IP KOTG TN 0UVOECN TOU UTTOAOYIOTH OTO TNAEQPWVIKO
KEVTPO PEOW TOU TOTTIKOU BIKTUOU).

3. Kavte KAIK oTn diadpour] Avoiypa> TnAé@uwvo Kail ETTIAEETE TO OXETIKO
TNAEQWVO.

4. KaraxwpioTe 10 PIN.

MpayuartotroinoTe TIG £MOUUNTEG pUBUICEIG.

6. BePaiwBeite 0T GUVEXEIQ, yia TN dlaUOPPWan, aTo ThAEPwvo. MNMaTtAaTe
TTPOG TOUTO dladoyIkd oTo Apxeio> AtroBnkeuon> TnAépwvo.

o



Francais

Informations importantes

Consignes de sécurité

Avertissement: Une utilisation non conforme de I'appareil peut
entrainer une électrocution mortelle et endommager ou détruire
I'appareil.
» Veuillez lire avec attention les notices se rapportant a I'appareil et les
conserver.

» Connectez le cable de raccordement de 'appareil uniquement aux boites
de jonction correctement installées et prévues a cet effet.

+ Utilisez exclusivement des accessoires et piéces de rechange d’origine.

Avertissement: Une installation incompléte ou défectueuse peut
entrainer des risques de blessures, par ex. en raison d’'un
dysfonctionnement des appels d'urgence.

* La configuration du produit se fait par le téléphone ou par le kit logiciel
COMfortel. L'aide correspondante est disponible en anglais ou en
allemand. Si vous ne maitrisez pas ces langues et si la terminologie ne
vous est pas familiére, faites-vous assister par un professionnel spécialisé
et comprenant ces langues.

Avertissement: La pénétration de liquides dans le boitier peut
entrainer une électrocution mortelle et endommager ou détruire
I'appareil.
» N'utilisez le téléphone que dans des piéces fermées et séches.
» Nettoyez I'appareil avec un chiffon Iégérement humide ou un chiffon
antistatique uniquement.

Avertissement: Des lignes de raccordement endommagées ainsi
que des dommages au niveau du boitier et sur I'appareil peuvent
entrainer une électrocution mortelle.

» Ne faites pas fonctionner d’appareil endommageé.
Avertissement: Des surtensions, telles que celles survenant lors

d’'un orage, peuvent entrainer une électrocution mortelle et
endommager ou détruire I'appareil.
» Lors d'un orage, ne touchez pas I'appareil.
* Tous les cables dans les batiments ne doivent étre posés que par un
électricien qualifié.

Avertissement: L'utilisation de micro-casques, de haut-parleurs ou
écouteurs externes non adaptés peut entrainer une perte auditive ou
dégrader la qualité de la conversation.

» Pour connecter un micro-casque, respectez les spécifications techniques.



Avertissement: En raison du faible champ magnétique dans
I'écouteur, des objets attirés par I'aimant, comme des aiguilles ou des
trombones, peuvent entrainer des blessures.

* Ne posez pas I'écouteur a proximité de tels objets.

Avertissement: Danger d’étouffement. L’appareil contient des petites
QB piéces susceptibles d’'étre avalées par des enfants en bas age.

» Tenez I'appareil hors de la portée des jeunes enfants.

Important: L’appareil n'est pas prévu pour des systémes de survie et/ou
pour des utilisations dans des installations nucléaires et ne doit donc pas étre
utilisé dans ces conditions. Une utilisation de I'appareil dans de telles
conditions doit obligatoirement faire I'objet d’'une autorisation individuelle
spécifique écrite du fabricant.

Une utilisation non conforme peut par ex. entrainer une limitation des

fonctions ou bien des dysfonctionnements, la destruction de I'appareil ou,

dans les cas les plus graves, la mise en danger de personnes.

« Si, malgré avoir lu le chapitre suivant, vous avez des doutes quant a
I'utilisation conforme, veuillez vous adresser a votre revendeur.

» Veuillez lire avec attention les notices se rapportant a I'appareil et les
conserver pour une utilisation ultérieure.

» Pour l'utilisation de certaines fonctions, il est nécessaire de procéder a une
mise a niveau logicielle (activation), a une activation chez I'exploitant du
réseau, une mise a jour et/ou a un paramétrage via le COMfortel Set.

Utilisation conforme

Téléphone pour connexion au port interne Sy ou Up d’un systéme de
télécommunication Auerswald/FONtevo (cf. spécifications techniques). Le
raccordement a un systéme de télécommunication d’'un autre fabricant ou a la
prise externe Sy d’un exploitant de réseau n’est pas prévu. Le téléphone filaire
est congu pour une utilisation dans des piéces fermées et séches.

Spécifications techniques

Tension en Alimentation par port interne Sy ou Upg du systéme
fonctionnement de télécommunication.

Puissance 1,1 W min., 2,0 W max.

absorbée

Raccordement au | Port interne Sy ou Upg du systéme de

systeme télécommunication : COMpact 3000 analogique/
ISDN/VolP, COMpact 2206 USB, COMpact 4410
USB, COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Mémoire Carte Micro-SD-/SDHC, 8 Go (recommandée, non
comprise a la livraison)




Affichages 14 LED, dont 10 multicolores, écran couleur TFT
3,56”, 320 x 240 pixels, rétro-éclairage

Eléments de Clavier téléphonique, 13 boutons a fonction fixe,
commande écran couleur avec fonction tactile, croix
directionnelle, 10 boutons a fonction programmable
avec LED (avec chacune deux fonctions a affecter
sur deux niveaux), boutons de fonction
supplémentaires sur I'écran

Ecouteur Audio a large bande, microphone a électret, haut-
parleur écouteur dynamique, compatible avec
appareils auditifs

Micro-casque Interface séparée pour les micro-casques
dynamiques

Crochet Commutateur de contact magnétique

commutateur

Boitier Plastique, noir

Dimensions 223 mm x 148/158/168 mm x 185 mm (I x h x p)

Poids env. 980 g

Température Fonctionnement : 0 a 40 °C, entreposage : - 30 a
+ 70 °C, sans condensation

Sécurité CE

Spécifications techniques pour la connexion d’un micro-casque

Alimentation microphone 0,5 mA max.
Sensibilité microphone -45dB
Impédance haut-parleur 150 Ohm
Sensibilité haut-parleur pour 1 kHz 19,5 +/- 3 dBPa/V
Limite du niveau sonore 24 dBPa

Consignes relatives a I’environnement

Si I'appareil n’est plus utilisé, veuillez vous assurer qu’il est mis au rebut de
maniére appropriée (et n’est pas jeté avec les ordures ménageéres).

&y Veuillez jeter ou recycler 'emballage dans le respect de I'environnement.

Renseignez-vous auprés de votre ville ou commune pour savoir quelles

sont les possibilités de recyclage et de gestion des déchets pouvant

s’appliquer a I'appareil. Si vous souhaitez que nous nous chargions de la
gestion des déchets liés a I'appareil, envoyez I'appareil a vos frais a Auerswald
GmbH & Co. KG.



Déclaration de conformité

Cet appareil répond aux exigences relatives a la santé, la sécurité et
I'environnement de toutes les directives européennes en vigueur. La
déclaration de conformité peut étre consultée sur Internet.

Conditions de garantie

1. La société Auerswald GmbH & Co. KG, Vor den Grashdfen 1, 38162 Cremlingen, Germany, accorde une garantie
fabricant sur ce produit, pour une durée de 24 mois suivant la date d’achat.

2. Pour vous en tant que client, ceci signifie que : nous garantissons que nos appareils sont irréprochables en I'état a
la livraison et que nous nous engageons, pour une période de 24 mois suivant cette date, a effectuer une réparation
ou a livrer une piéce de rechange sans colits supplémentaires dans le cas ou un défaut de fabrication serait constaté,
et que nous renongons a exiger de vous, en qualité de client, la présentation d’une preuve de présence du défaut a la
livraison comme ceci est généralement le cas dans le respect de la garantie Iégale. Lors de la réparation ou de la
livraison de la piéce de rechange, nous utilisons des pieces neuves ou des piéces a I'état neuf. Le cas échéant, les
piéces retirées de I'appareil nous appartiennent et peuvent étre détruites.

3. En plus de cette garantie, le client dispose pleinement des droits relatifs a la garantie Iégale de conformité sur la
base du contrat de vente conclu avec le distributeur/revendeur qui lui sont conférés par la loi. La garantie Iégale de
conformité ne concerne que la qualité de la marchandise au moment de la vente (transfert), contrairement a notre
garantie fabricant.

4. Vous ne pouvez faire valoir cette garantie que lorsque vous envoyez a vos frais 'appareil défectueux accompagné
d’une preuve d’achat (facture ou ticket de caisse) a Auerswald GmbH & Co. KG ou, hors d’Allemagne, a notre
importateur général ou distributeur sur place. Veuillez joindre a cet envoi une description détaillée du défaut ainsi que
votre numéro de téléphone afin que nous puissions vous contacter au besoin. Afin d’éviter tout dommage lors du
transport, veuillez vous assurer que I'appareil est placé dans un emballage adapté (par ex. emballage original placé
dans un carton).

5. Les dommages résultant d’'une utilisation non conforme, d’erreurs de manipulation, d’une utilisation abusive,
d'influences extérieures, de la foudre/d’une surtension, d’'une modification du produit et d’ajouts, sont exclus de la
garantie fabricant. Les piéces d’usure sont également exclues de la garantie (par ex. piles, fusibles, batteries, cartes
mémoires), tout comme les dommages résultant des piéces d’'usures (par ex. en raison de piles déchargées). Les
dommages résultant du transport, les dommages consécutifs ainsi que les codts liés aux temps d’attente et
d’acheminement, sont également exclus de la garantie fabricant.

6. La garantie est rendue caduque lors de I'exécution de réparations effectuées par des organismes non autorisés.

Premiére mise en service

Raccordez le téléphone comme représenté sur l'illustration sous
Raccordement.

Premiére configuration du téléphone
Prérequis :

* Numéros d’appel internes paramétrés dans le systéme de
télécommunication

Suivez les indications dans le téléphone.

Remarque: Le MSN est le numéro d’appel interne paramétré dans le
systéme de télécommunication.

Configuration via le COMfortel Set

Prérequis :

» Java Runtime est installé (disponible sur notre site Internet)
» COMfortel Set est installé (disponible sur notre site Internet)



» Connexion existante du PC a une interface PC du systéme de
télécommunication (cf. notice du systéme de télécommunication)

1. Lancez le programme.

2. Sous Options > Interface, sélectionnez l'interface que vous utilisez (par
ex. Réseau IP lors de la connexion du PC avec le systéeme de
télécommunication via le réseau local).

Cliquez sur Ouvrir > Téléphone et sélectionnez le téléphone concerné.
Entrez le code PIN.
Effectuez les réglages souhaités.

Enregistrez ensuite la configuration dans le téléphone. Cliquez enfin sur
Fichier > Enregistrer > Téléphone dans cet ordre.

o0k w



Italiano

Informazioni importanti

Indicazioni di sicurezza
Avvertenza: L’uso improprio del dispositivo puo causare una scossa
elettrica mortale e danneggiare o distruggere il dispositivo.
» Leggere e conservare le guide fornite insieme al dispositivo.

» Collegare il cavo del dispositivo solo a prese idonee e installate a regola
d’arte.

+ Utilizzare esclusivamente accessori e ricambi originali.
Avvertenza: Un’eventuale configurazione incompleta o errata pud

risultare pericolosa per gli utenti, per es. nel caso in cui non sia
possibile effettuare le chiamate di emergenza.

* |l prodotto puod essere configurato tramite il telefono o tramite il software
COMfortel Set. La guida corrispondente & disponibile in lingua inglese o
tedesca. In caso di scarsa padronanza di tali lingue e dei termini tecnici
utilizzati, rivolgersi a un tecnico con conoscenze linguistiche adeguate.

Avvertenza: La penetrazione di liquidi nel dispositivo pud causare
una scossa elettrica mortale e danneggiare o distruggere il dispositivo.
« Utilizzare il telefono solo in locali chiusi e asciutti.
« Pulire il dispositivo solo con un panno leggermente inumidito o un panno
antistatico.

Avvertenza: | cavi di collegamento danneggiati, cosi come eventuali
danni in corrispondenza dell’involucro e del dispositivo, possono
causare una scossa elettrica mortale.

» Non mettere in funzione un dispositivo danneggiato.
Avvertenza: Le sovratensioni, per esempio quelle che si formano

durante i temporali, possono causare una scossa elettrica mortale e
danneggiare o distruggere il dispositivo.

» Durante i temporali evitare di toccare il dispositivo.
» Tutti i cavi dell’edificio devono essere posati da un elettricista qualificato.
Avvertenza: Cuffie auricolari, altoparlanti esterni o ricevitori

inadeguati possono danneggiare I'udito o disturbare il collegamento
audio.

» Rispettare i dati tecnici per il collegamento di una cuffia auricolare.
Avvertenza: Gli oggetti attirati dal debole campo magnetico del
ricevitore, come puntine e fermagli, possono causare lesioni.

» Non appoggiare il ricevitore in prossimita di tali oggetti.



Qé) Avvertenza: Pericolo di soffocamento. Il dispositivo contiene
Qi particolari di piccole dimensioni che possono essere inghiottiti dai
bambini.

» Tenere il dispositivo fuori dalla portata dei bambini.

Importante: Il dispositivo non € progettato per sistemi vitali e/o per
applicazioni nell’ambito di impianti nucleari e pertanto non deve essere
utilizzato a tali scopi. L'uso del dispositivo per applicazioni di questo tipo
presuppone obbligatoriamente la presenza di un consenso/una
dichiarazione scritti del produttore per il caso specifico.

L’uso improprio puo limitare le funzioni del dispositivo, causarne un

malfunzionamento o la distruzione oppure, nel peggiore dei casi, creare

situazioni pericolose per le persone.

* Qualora, anche dopo avere letto il capitolo seguente, permangano dubbi
sull’'uso previsto, rivolgersi al proprio rivenditore specializzato.

» Leggere le guide fornite insieme al dispositivo e conservarle per ogni
utilizzo futuro.

» Per usufruire di alcune funzioni pud essere necessario richiedere un
ampliamento software (attivazione) o presso I'operatore di rete, eseguire
un aggiornamento del firmware e/o eseguire una configurazione tramite
COMfortel Set.

Uso previsto

Telefono di sistema da collegare alla porta Sy 0 Upg interna di un centralino
Auerswald/FONtevo (vedere i dati tecnici). Il collegamento a un centralino di un
altro produttore o alla porta Sy esterna di un operatore di rete non & consentito.
Il telefono fisso e progettato per essere utilizzato in locali chiusi e asciutti.

Dati tecnici
Tensione di Alimentazione dal centralino tramite porta Sy 0 Upg
funzionamento interna

Potenza assorbita | Min. 1,1 W, max. 2,0 W

Collegamento al Porta Sy 0 Upg interna dei centralini: COMpact 3000
sistema analogico/ISDN/VolP, COMpact 2206 USB,
COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R,
COMmander 6000/R/RX. COMmander Basic 2/19",

COMmander Business/19"

Memoria Scheda Micro-SD/SDHC, 8 GB (consigliata, non in
dotazione)

Display 14 LED, 10 dei quali a piu colori, display a colori TFT

da 3,5”, 320 x 240 pixel, retroilluminazione



Elementi di Tastiera, 13 tasti funzione fissi, display a colori con
comando funzione touch, tastierino direzionale, 10 tasti
funzione programmabili con LED (ciascuno con un
massimo di due funzioni assegnabili su due livelli),
ulteriori tasti funzione touch sul display

Ricevitore Audio a banda larga, microfono a electret, ricevitore
con altoparlante dinamico, compatibile con
apparecchio acustico

Cuffia auricolare Interfaccia separata per cuffie auricolari dinamiche

Commutatore a Contatto di commutazione magnetico

forchetta

Involucro Plastica, nera

Dimensioni 223 mm x 148/158/168 mm x 185 mm (La x A x P)
Peso Circa 980 g

Temperatura Funzionamento: da 0 a 40 °C, stoccaggio: da -30 a

+70 °C, senza formazione di condensa

Sicurezza CE

Dati tecnici per il collegamento di una cuffia auricolare

Assorbimento di corrente del microfono Max. 0,5 mA
Sensibilita del microfono -45dB
Impedenza degli altoparlanti 150 Ohm
Sensibilita degli altoparlanti a 1 kHz 19,5 +/- 3 dBPa/V
Limite del livello sonoro 24 dBPa

Note di carattere ambientale

Qualora il dispositivo non serva piu, smaltirlo a regola d’arte (non insieme ai
normali rifiuti domestici).

Y. Smaltire il materiale dell'imballaggio nel rispetto del’ambiente e delle
%9 norme vigenti in materia.

Informarsi presso le autorita locali o comunali sulle modalita di
smaltimento corrette ed ecologiche del dispositivo. Su richiesta,
Auerswald puo farsi carico dello smaltimento. Per avvalersi di tale
possibilita spedire il dispositivo a proprie spese ad Auerswald GmbH & Co. KG.

Dichiarazione di conformita

Il presente dispositivo soddisfa i requisiti fondamentali in materia di salute,
sicurezza e ambiente di tutte le direttive europee applicabili. La dichiarazione
di conformita pud essere consultata in Internet.



Condizioni di garanzia

1. In qualita di produttore, Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, concede
su questo prodotto 24 mesi di garanzia del produttore a partire dalla data di acquisto.

2. Per il consumatore questo significa che: garantiamo la consegna di dispositivi privi di difetti e provvediamo alla loro
riparazione o sostituzione gratuita qualora emerga un difetto di produzione per 24 mesi a partire dalla data di
consegna. Facciamo a meno della prova che il consumatore deve fornire ai sensi della garanzia di legge a
dimostrazione che il difetto era gia presente al momento della consegna. Per la riparazione o la fornitura sostitutiva
utilizziamo componenti nuovi o come nuovi. | componenti eventualmente rimossi dal dispositivo diventano di nostra
proprieta e possono essere distrutti.

3. Oltre alla presente garanzia, al cliente spettano tutti i diritti di legge nei confronti del fornitore risultanti dalla garanzia
per vizi della cosa venduta sulla base del contratto di compravendita. A differenza della garanzia del produttore da noi
concessa, la garanzia di legge per i vizi della cosa venduta riguarda unicamente le condizioni al momento della vendita
(consegna).

4. E possibile usufruire della presente garanzia solo inviando ad Auerswald GmbH & Co. KG o, se vi trovate al di fuori
della Germania, al nostro importatore generale o distributore locale, il dispositivo difettoso unitamente a un documento
giustificativo dell’acquisto (fattura o scontrino inequivocabili). Allegare allinvio anche una descrizione dettagliata del
difetto e riportare il proprio numero di telefono per eventuali richieste di chiarimento. Per evitare che il dispositivo
subisca danni durante il trasporto, imballarlo adeguatamente (per es. inserire il dispositivo nell'imballaggio originale,
quindi all'interno di un'’ulteriore scatola di cartone).

5. La garanzia del produttore non copre i danni causati da gestione inadeguata, errore di azionamento, uso improprio,
influssi esterni, fulmini/sovratensioni, modifiche del prodotto e aggiunta di componenti. La garanzia non si applica ai
componenti soggetti a usura (per es. batterie, fusibili, batterie ricaricabili, schede di memoria) e non copre eventuali
danni causati da tali componenti (per es. in seguito all'esaurirsi delle batterie). La garanzia non copre neppure i danni
di trasporto, i danni indiretti e i costi subiti in seguito ai tempi di fuori servizio e di transito.

6. Eventuali riparazioni eseguite da centri non autorizzati provocano la decadenza del diritto alla garanzia.

Prima messa in funzione
Collega il telefono come illustrato nella figura riportata sotto a “Collegamento”.

Prima configurazione del telefono

Requisiti:

» numero di telefono interno configurato nel centralino.
Segui le istruzioni sul telefono.

Nota: L'MSN é il numero di telefono interno configurato nel centralino.

Configurazione tramite COMfortel Set

Requisiti:

+ Java Runtime installato (sono disponibili sul nostro sito web)
+ COMfortel Set installato (sono disponibili sul nostro sito web)

» Connessione tra il PC e un’interfaccia PC del centralino (vedere la guida del
centralino)

1. Awvia il programma.

2. Alla voce Opzioni > Interfaccia seleziona l'interfaccia utilizzata (per es.
Rete IP nel caso in cui il PC sia connesso con il centralino tramite la rete

locale).
3. Clicca su Apri > Telefono e seleziona il telefono in oggetto.
4. Immetti il PIN.

5. Esegui le impostazioni desiderate.



6. quindi salva la configurazione nel telefono. Per fare cio clicca su File >
Salva > Telefono.



Nederlands

Belangrijke informatie

Veiligheidsinstructies

Waarschuwing: Verkeerde omgang met het apparaat kan
levensgevaarlijke elektrische schokken tot gevolg hebben en het
apparaat beschadigen.

» Lees de bij het apparaat behorende handleidingen door en bewaar deze.

 Sluit de aansluitkabel van het apparaat alleen aan op de daarvoor
bedoelde en deskundig geinstalleerde contactdozen

» Gebruik uitsluitend originele toebehoren en originele reservedelen.

Waarschuwing: Onvolledige of verkeerde configuratie kan gevaar
voor personen tot gevolg hebben, bijvoorbeeld doordat noodoproepen
niet kunnen worden uitgevoerd.

» De configuratie van het apparaat geschiedt via de telefoon of via de
software COMfortel-set. De bijbehorende hulp is beschikbaar in de
Engelse of de Duitse taal. Wanneer u niet bekend bent met deze talen en
de gebruikte vaktermen, schakel dan een vaktechnicus in die deze wel
beheerst.

Waarschuwing: Vloeistof dat de behuizing binnendringt kan
levensgevaarlijke elektrische schokken tot gevolg hebben en het
apparaat beschadigen.
* Gebruik de telefoon alleen in gesloten, droge ruimten.
* Reinig het apparaat alleen met een licht vochtige doek of een antistatische
doek.

Waarschuwing: Beschadigde aansluitkabels en beschadigingen aan
de behuizing en aan het apparaat zelf, kunnen levensgevaarlijke
elektrische schokken tot gevolg hebben.

* Neem een beschadigd apparaat nooit in bedrijf.
Waarschuwing: Overspanningen, zoals bij onweer kunnen optreden,

kunnen levensgevaarlijke elektrische schokken tot gevolg hebben of
het apparaat beschadigen of kapot maken.

» Raak het apparaat niet aan tijdens een onweersbui.
» Laat door een elektrotechnicus alle kabels binnen het gebouw installeren.
Waarschuwing: Ongeschikte headsets, externe luidsprekers of

koptelefoons kunnen tot gehoorschade leiden of de spraakverbinding
storen.

* Neem de technische gegevens voor het aansluiten van een headset in
acht.



Waarschuwing: Het zwakke magnetische veld in de koptelefoon kan
objecten als naalden en paperclips aantrekken. Deze objecten kunnen
letsel veroorzaken.

* Leg de koptelefoon niet in de buurt van dergelijke objecten neer.

Waarschuwing: Verstikkingsgevaar. Het apparaat bevat kleine
QB onderdelen die door kleine kinderen kunnen worden ingeslikt.

* Houd het apparaat buiten bereik van kleine kinderen

Belangrijk: Het apparaat is niet bedoeld, en mag daarom niet worden
gebruikt, voor life-support systemen en/of toepassingen binnen nucleaire
inrichtingen. Voor gebruik van het apparaat in dergelijke toepassingen moet
verplicht een op het individuele geval afgestemde schriftelijke toestemming/
verklaring van de fabrikant vooraf worden afgegeven.

Niet correct gebruik kan bijvoorbeeld functiebeperkingen of storingen,

onherstelbare schade aan het apparaat of, in het ergste geval, gevaar voor

personen tot gevolg hebben.

» Wanneer u betreffende het correcte gebruik, ook na het lezen van het
volgende hoofdstuk, nog twijfelt, neem dan contact op met uw dealer.

» Lees de bij het apparaat behorende handleidingen door en bewaar deze
voor later gebruik.

» Voor het gebruik van bepaalde functies is een software-uitbreiding
(vrijschakeling), een vrijschakeling bij de netbeheerder, een firmware-
update en/of een configuratie via de COMfortel Set vereist.

Correct gebruik

Systeemtelefoon voor aansluiting op de interne Sy- of Upg-poort van een
telefooncentrale van Auerswald/FONtevo (zie technische gegevens). De
verbinding is niet bedoeld voor aansluiting op een telefooncentrale van een
andere fabrikant of op de externe Sy-aansluiting van een netbeheerder. De
bedrade telefoon is bedoeld om in gesloten, droge ruimten te worden gebruikt.

Technische gegevens

Bedrijfsspanning Voeding via interne Sy- of Upg-poort uit de
telefooncentrale

Opgenomen Min. 1,1 W, max. 2,0 W

vermogen

Systeemaansluiting Interne Sy- of Upg-poort van de telefooncentrale:

COMpact 3000 analog/ISDN/VolP, COMpact 2206
USB, COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R,
COMmander 6000/R/RX. COMmander Basic 2/19",
COMmander Business/19"

Geheugen Micro-SD-/SDHC-kaart, 8 GB (aanbevolen, niet bij de
levering inbegrepen)




Weergave 14 LEDs, waarvan 10 meerkleurig, 3,5 inch TFT-
kleurendisplay, 320 x 240 pixel,
achtergrondverlichting

Bedieningselementen | Toetsenblok, 13 vaste functietoetsen, kleurendisplay
met touch-functie, besturingspaneel, 10
programmeerbare functietoetsen met LED (met elk
tot twee functies die op twee niveaus toewijsbaar
zijn), overige touch-functietoetsen op de display

Hoorn Wideband audio, elektretmicrofoon, dynamische
luidspreker handset, compatibel met
gehoorapparaten

Headset Afzonderlijke interface voor dynamische headsets

Telefoonhaak Magnetisch schakelcontact

Behuizing Kunststof, zwart

Afmetingen 223 mm x 148/158/168 mm x 185 mm (B x H x D)

Gewicht Ca. 98049

Temperatuur Bedrijf: 0 tot 40 °C, opslag: - 30 tot + 70 °C, niet
condenserend

Veiligheid CE

Technische gegevens voor het aansluiten van een headset

Stroomverbruik microfoon Max. 0,5 mA
Gevoeligheid microfoon -45dB
Impedantie luidspreker 150 Ohm
Gevoeligheid luidspreker bij 1 kHz 19,5 +/- 3 dBPa/V
Grens geluidsniveau 24 dBPa

Milieuvoorschriften

Wanneer het apparaat eens is uitgediend, let dan op een correcte afvoer (niet
in het normale huisvuil).

&y Voer het verpakkingsmateriaal correct af om het milieu te sparen.

Informeer bij uw lokale autoriteiten naar de mogelijkheden voor het
milieuvriendelijk afvoeren van uw apparaat. Wanneer u wilt, dat wij het

=== apparaatvoor u afvoeren, stuur het apparaat dan voor uw eigen rekening
naar Auerswald GmbH & Co. KG.



Conformiteitsverklaring

Dit apparaat voldoet aan de principiéle gezondheids-, veiligheids- en
milieuvoorschriften uit alle relevante Europese richtlijnen. De
conformiteitsverklaring kan op internet worden ingezien.

Garantievoorwaarden

1. Auerswald GmbH & Co. KG, Vor den Grashdéfen 1, 38162 Cremlingen, Germany, verleent als fabrikant op dit
product 24 maanden fabrieksgarantie vanaf de koopdatum.

2. Dit betekent voor u als gebruiker: Wij garanderen, dat onze apparaten bij de overdracht foutloos functioneren en
zorgen tot 24 maanden vanaf deze datum voor een kostenloze reparatie of wij leveren kosteloos een vervangen, indien
een fabricagefout optreedt en zien af van het door u als verbruiker aan te voeren bewijs als bij de wettelijke garantie,
dat deze fout op het tijdstip van overdracht al aanwezig was. Bij de reparatie of de levering van vervangende
onderdelen gebruiken wij nieuwe of gelijkwaardige onderdelen. Het apparaat en eventueel uitgenomen onderdelen
gaan over in ons eigendom en mogen worden vernietigd.

3. Naast deze garantie heeft de klant in volledige omvang het wettelijke recht op garantie op basis van het koopverdrag
ten opzichte van de leverancier. De wettelijke garantie betreft echter in tegenstelling tot onze fabrieksgarantie alleen
de kwaliteit op het tijdstip van verkoop (overdracht).

4. U kunt alleen aanspraak maken op deze garantie, wanneer u het defecte apparaat met een eenduidig koopbewijs
(factuur of kassabon) op uw kosten aan Auerswald GmbH & Co. KG verzendt of, buiten Duitsland, aan onze importeur
of distributeur ter plaatse. Voeg aan deze zending een uitgebreide foutbeschrijving tot en vermeld voor eventuele
vragen ook uw telefoonnummer. Zorg voor geschikte transportverpakking om transportschade te voorkomen
(bijvoorbeeld originele verpakking met een omdoos).

5. Uitgesloten van de fabrieksgarantie is schade, die ontstaat door verkeerde behandeling, bedieningsfouten,
misbruik, externe invioeden, blikseminslag/overspanning, veranderingen van het product en aangebouwde
componenten. Bovendien zijn de slijtende delen uitgesloten (bijv. batterijen, zekeringen, accu's, geheugenkaarten), en
door de slijtende delen veroorzaakte schade (bijv. door het uitlopen van batterijen). Ook transportschade,
gevolgschade en kosten voor uitvaltijden zijn uitgesloten.

6. De garantie komt te vervallen wanneer reparaties door niet geautoriseerde instanties worden uitgevoerd.

Eerste ingebruikname

Sluit de telefoon aan zoals op de afbeelding onder aansluiting wordt
weergegeven.

Eerste configuratie via de telefoon

Voorwaarden:

+ Bij de telefooncentrale ingesteld intern telefoonnummer
Volg de instructies in de telefoon.

Opmerking: De MSN is het in de telefooncentrale ingestelde interne
telefoonnummer.

Configuratie via COMfortel Set

Voorwaarden:
+ Java Runtime geinstalleerd (deze vindt u op onze internetpagina)
» COMfortel Set geinstalleerd (deze vindt u op onze internetpagina)

» Bestaande verbinding van de PC met een PC-interface van de
telefooncentrale (zie handleiding van de telefooncentrale)

1. Start het programma.
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Selecteer onder Options > Interface de door u gebruikte interface (bijv. IP
network als de PC middels het lokale netwerk met de telefooncentrale is
verbonden).

Klik op Open > Telephone en selecteer de betreffende telefoon.

Voer de PIN in.

Voer de gewenste instellingen door.

Sla hierna de configuratie op in de telefoon. Klik hiervoor
achtereenvolgens op File > Save > Telephone.



Polski

Wazne informacje

Wskazéwki bezpieczenstwa

Ostrzezenie: Nieprawidtowe uzywanie urzgdzenia moze
doprowadzi¢ do groznego dla zycia porazenia prgdem, a takze
uszkodzi¢ lub zniszczy¢ urzadzenie.

» Nalezy przeczytaé zatgczone instrukcje obstugi urzadzenia i zachowac je.

* Przewody urzgdzenia nalezy podtgcza¢ wytgcznie do odpowiednich i
fachowo zainstalowanych gniazd przytagczeniowych

» Nalezy uzywac wytacznie oryginalnych akcesoridw i czesci zamiennych.

Ostrzezenie: Niekompletna lub btedna konfiguracja moze prowadzié¢
do zagrozenia zycia, np. poprzez brak mozliwosci wykonania
potgczenia w celu wezwania pomocy.

» Konfiguracja produktu odbywa sie przez telefon lub przez
oprogramowanie COMfortel Set. Wtasciwa pomoc jest dostepna w jezyku
angielskim lub niemieckim. Jezeli te jezyki i zastosowane fachowe pojecia
sprawiajg trudno$¢, to nalezy powierzy¢ te czynno$ci osobie z
odpowiednimi kwalifikacjami jezykowymi i fachowymi.

Ostrzezenie: Zalanie obudowy ptynem moze doprowadzi¢ do
Smiertelnego porazenia prgdem, a takze uszkodzi¢ lub zniszczy¢
urzgdzenie.

» Telefonu nalezy uzywaé wytacznie w zamknietych i suchych
pomieszczeniach.

» Urzagdzenie nalezy czy$ci¢ wytgcznie za pomocg lekko zwilzonej szmatki
lub Sciereczki antystatycznej.

Ostrzezenie: Uszkodzenia przewodéw, obudowy lub urzgdzenia
mogg prowadzi¢ do Smiertelnego porazenia prgdem.

» Nie nalezy wtgcza¢ uszkodzonego urzadzenia.
Ostrzezenie: Wystepujgce podczas burzy przepiecia moga

doprowadzi¢ do $miertelnego porazenia prgdem, a takze uszkodzi¢
lub zniszczy¢ urzadzenie.
» W czasie burzy nie nalezy dotykaé urzadzenia.
* Rozmieszczaniem przewodéw w budynku powinien zajgc¢ sie
wykwalifikowany elektryk.

Ostrzezenie: Nieodpowiednie zestawy stuchawkowe, zewnetrzne
gtosniki lub stuchawki mogg prowadzi¢ do uszkodzenia stuchu lub
powodowac zaktdcenia potgczen glosowych.

* Przestrzegac¢ danych technicznych dotyczacych podtgczania zestawu
stuchawkowego.



Ostrzezenie: Przedmioty przyciagniete przez stabe pole
magnetyczne w stuchawce, takie jak igty lub spinacze biurowe, mogg
spowodowac¢ skaleczenia.

» Nie nalezy umieszczac¢ stuchawki w poblizu takich przedmiotow.

Qé) Ostrzezenie: Niebezpieczenstwo uduszenia. W urzadzeniu znajdujg
QB sie drobne elementy, ktdre dzieci mogg potknac.

» Urzgdzenie nalezy przechowywac poza zasiegiem matych dzieci

Wazne: NNiniejsze urzadzenie nie jest przeznaczone do uzytku w
systemach podtrzymywania zycia i/lub w urzgdzeniach nuklearnych i nie
powinno by¢ w nich stosowane. Aby niniejsze urzadzenie mogto byc¢
wykorzystywane do tego typu zastosowan, dla kazdego pojedynczego
przypadku bezwzglednie wymagana jest uprzednia pisemna zgoda lub
oswiadczenie ze strony producenta.

Uzytkowanie niezgodne z przeznaczeniem moze prowadzi¢ np. do
ograniczenia funkcjonalnosci, zaktécen w dziataniu urzadzenia, jego
zniszczenia, a w skrajnym wypadku do zagrozenia zycia.

» Jezeli po przeczytaniu ponizszego rozdziatu nadal zachodzg watpliwosci
co do zgodnego z przeznaczeniem uzytkowania urzadzenia, nalezy
zasiegna¢ informacji u sprzedawcy.

» Nalezy przeczytaé zatgczone instrukcje obstugi urzadzenia i zachowac je
do pézniejszego uzytku.

» Do korzystania z niektérych funkcji wymaga ich rozszerzenia
oprogramowania (odblokowania), aktywacja u operatora sieci, aktualizacja
oprogramowania sprzetowego i/lub konfiguracja przez COMfortel Set.

Uzytkowanie zgodne z przeznaczeniem

Telefon systemowy do podtgczania do wewnetrznego portu Sy lub Up centrali
telefonicznej firmy Auerswald/FONtevo (patrz Dane techniczne). Podtgczenie
do centrali telefonicznej innego producenta lub do zewnetrznego przytgcza Sy
operatora sieci nie jest przewidziane. Jest to telefon przewodowy,
przeznaczony do uzytku w zamknigtych i suchych pomieszczeniach.

Dane techniczne

Napiecie robocze | Zasilanie przez wewnetrzny port Sy lub Up z centrali
telefonicznej

Pobdér mocy Min. 1,1 W, maks. 2,0 W
Przytacze Wewnetrzny port Sy lub Upq central telefonicznych:
systemowe COMpact 3000 analog/ISDN/VolP, COMpact 2206

USB, COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R,
COMmander 6000/R/RX. COMmander Basic 2/19",
COMmander Business/19"




Pamiegé Karta micro SD/SDHC, 8 GB (zalecana, dostepna
oddzielnie)
Wskazniki 14 diod LED, w tym 10 wielokolorowych, wyswietlacz

kolorowy TFT 3,5 cala, 320 x 240 pikseli,
podswietlenie tta

Elementy obstugi

Klawiatura przyciskowa, 13 przyciskéw statych,
wyswietlacz kolorowy z obstugg dotykowa, podkiadka
kierunkowa, 10 programowalnych przyciskow funkc;ji
z diodg LED (mozliwos¢ przypisania maksymalnie
dwadch funkcji na dwdch poziomach), dalsze
dotykowe przyciski funkcji na ekranie

Stuchawka Dzwiek szerokopasmowy, mikrofon elektretowy,
dynamiczny gtosnik stuchawki, kompatybilny z
aparatami stuchowymi

Zestaw Osobne zigcze dla przewodowych zestawow

stuchawkowy stuchawkowych

Przetacznik Magnetyczny zestyk przetgczny

aparatowy

Obudowa Tworzywo sztuczne, czarny

Wymiary 223 mm x 148/158/168 mm x 185 mm (szer. x wys. X
gt)

Waga Ok. 980 g

Temperatura Eksploatacja: od 0 do 40 °C, przechowywanie: od -30

do +70 °C, bez kondensacji

Zabezpieczenia

CE

Dane techniczne przytacza zestawu stuchawkowego

Pobdr pradu przez mikrofon Maks. 0,5 mA
Czutos¢ mikrofonu -45dB
Impedancja gtosnikow 150 omow
Czutos¢ gtosnikow przy 1 kHz 19,5 +/- 3 dBPa/V
Granica poziomu dzwigku 24 dBPa

Informacje dotyczace ochrony srodowiska

Po zakonczeniu uzytkowania urzadzenia nalezy zadbac o jego odpowiednig

utylizacje (oddzielnie od odpadéw komunalnych).

{5y Materiat opakowaniowy nalezy zutylizowaé w sposéb zgodny z zasadami

ochrony $srodowiska.

W administracji miasta lub gminy nalezy zasiegng¢ informaciji o
mozliwosci prawidtowej utylizacji urzadzenia, zgodnej z zasadami



ochrony srodowiska. Urzgdzenie, ktére ma zosta¢ zutylizowane, mozna
réwniez przestaé¢ na swoj koszt do firmy Auerswald GmbH & Co. KG.

Deklaracja zgodnosci

Niniejsze urzadzenie spetnia podstawowe wymagania dotyczgce zdrowia,
bezpieczenstwa i ochrony srodowiska naturalnego wszystkich wtasciwych
dyrektyw europejskich. Z tg deklaracjg zgodnosci mozna zapoznac sie w
Internecie.

Warunki gwarancji

1. Spotka Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, przyznaje jako producent
24-miesieczng gwarancje producenta na ten produkt, ktéra rozpoczyna sie w dniu zakupu.

2. Dla Panstwa jako konsumenta oznacza to, co nastepuje: Gwarantujemy, ze nasze urzadzenia w momencie ich
przekazania nie posiadajg usterek, i zapewniamy bezptatng naprawe lub darmowag wymiane w ciggu 24 miesiecy od
tej daty, w przypadku gdy w urzgdzeniu wykryta zostanie wada fabryczna, i rezygnujemy z obowigzku przedstawienia
przez Panstwa jako konsumenta dowodu, ze dana usterka wystgpowata juz w momencie przekazania produktu, co
jest wymagane w przypadku ustawowej rekojmi. W przypadku naprawy lub wymiany uzywamy nowych czesci lub
czegsci posiadajgcych wartosé nowego produktu. Ewentualne cze$ci wymontowane z urzadzenia stajg sie naszg
wiasnoscig i mogg zostaé zutylizowane.

3. Oprdcz niniejszej gwarancii klientowi w petnym zakresie przystugujg ustawowe prawa z tytutu rekojmi przyznawanej
na mocy umowy sprzedazy zawartej z dostawcyg. W przeciwienstwie do naszej gwarancji producenta ustawowa
rekojmia dotyczy tylko jakosci w momencie sprzedazy (przekazania).

4. Z niniejszej gwarancji moga Panstwo skorzysta¢ wylgcznie po przestaniu wadliwego urzadzenia na wiasny koszt
wraz z jednoznacznym dowodem zakupu (rachunkiem lub paragonem) do firmy Auerswald GmbH & Co. KG badz do
naszego importera generalnego lub miejscowego dystrybutora, w przypadku klientéw spoza Niemiec. Prosimy takze
o dotgczenie do wysytki szczegotowego opisu uszkodzenia i o podanie numeru telefonu do kontaktu w przypadku
ewentualnych pytan. Aby unikng¢ uszkodzen w transporcie, nalezy zadba¢ o odpowiednie opakowanie na czas
transportu (np. opakowanie oryginalne i karton zewnetrzny).

5. Gwarancjg producenta nie sg objete szkody, ktore powstajg na skutek niewtasciwego uzytkowania, btedu operatora,
naduzywania, czynnikdw zewnetrznych, uderzenia pioruna/przepiecia, modyfikacji produktu lub jego rozbudowy.
Ponadto gwarancja nie obejmuje czgsci ulegajgcych zuzyciu (np. baterii, bezpiecznikéw, akumulatoréw, kart pamigci),
a takze uszkodzen spowodowanych przez takie czesci (np. w wyniku wyczerpania sig baterii). Ponadto z zakresu
gwarancji wytaczone sg szkody powstate w transporcie, szkody posrednie, koszty powstate w trakcie awarii i
transportu.

6. Gwarancja wygasa w przypadku wykonania napraw w nieautoryzowanym serwisie.

Pierwsze uruchomienie

Telefon nalezy podtaczy¢ w sposéb pokazany na ilustracji w punkcie
Podtaczanie.

Pierwsza konfiguracja przez telefon

Wymagania:

+ wewnetrzny numer telefonu skonfigurowany w centrali telefonicznej
Postepuj zgodnie z instrukcjami w telefonie.

Wskazéwka: MSN to wewnetrzny numer telefonu skonfigurowany w centrali
telefoniczne;.




Konfiguracja przez COMfortel Set

Wymagania:

ook w

zainstalowane oprogramowanie Java Runtime (dostepny na naszej stronie
internetowej)

zainstalowane oprogramowanie COMfortel Set (dostepny na naszej stronie
internetowej)

nawigzane potgczenie miedzy komputerem a interfejsem komputera w
centrali telefonicznej (patrz instrukcja centrali telefonicznej)

Uruchom program.

W menu Options > Interface wybierz uzywany przez siebie interfejs (np.
IP network w przypadku potgczenia komputera z centralg telefoniczng
przez siec¢ lokalng).

Kliknij Open > Telephone i wybierz wtasciwy telefon.
Podaj kod PIN.
Wybierz preferowane ustawienia.

Nastepnie zapisz konfiguracje w telefonie. Kliknij po kolei File > Save >
Telephone.
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